
GMSplus

User Manual

GeoSIG Ltd, Wiesenstrasse 39, 8952 Schlieren, Switzerland
Phone: + 41 44 810 2150, Fax: + 41 44 810 2350

info@geosig.com, www.geosig.com



2 / 150
GMSplus User Manual

2023-10-02 / V25

Disclaimer
GeoSIG Ltd reserves the right to change the information contained in this document without notice. While the information contained herein
is assumed to be accurate, GeoSIG Ltd assumes no responsibility for any errors or omissions.

Copyright Notice
No part of this document may be reproduced without the prior written consent of GeoSIG Ltd. Software described in this document is
furnished under a license and may only be used or copied in accordance with the terms of such a license.

Trademark
All brand and product names mentioned are trademarks or registered trademarks of their respective holders.

All rights reserved.

GeoSIG Ltd

Switzerland



GMSplus User Manual
2023-10-02 / V25 3 / 150

Table of Contents

Applicability of This Manual 7

Warnings and Safety 8

GeoSIG Cybersecurity Recommendations 11

Symbols and Abbreviations 14

1 Introduction 15

2 Incoming Inspection 16
2.1 Damage During Shipment . . . . . . . . . . . . . . . . . . . . . . . . . 16
2.2 Warranty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

2.2.1 Limitation of Warranty . . . . . . . . . . . . . . . . . . . . . . . . 16

3 Description 17
3.1 Housing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.2 Housing Lid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.3 Base Plate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.4 Connectors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

3.4.1 Standard External Connectors. . . . . . . . . . . . . . . . . . . . . 19
3.4.2 Optional External Connectors . . . . . . . . . . . . . . . . . . . . . 19
3.4.3 Optional External Antennas . . . . . . . . . . . . . . . . . . . . . . 20
3.4.4 Connectivity Options . . . . . . . . . . . . . . . . . . . . . . . . 20
3.4.5 Internal Connector . . . . . . . . . . . . . . . . . . . . . . . . . 20

3.5 Visual Indicators. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
3.5.1 Detail Description . . . . . . . . . . . . . . . . . . . . . . . . . 22

3.6 Internal Batteries . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.6.1 Main Battery . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.6.2 Backup Battery . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.6.3 Storage (Instrument Shelf Life) . . . . . . . . . . . . . . . . . . . . 26

3.7 Power Supply . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
3.7.1 Choice of Power Supply . . . . . . . . . . . . . . . . . . . . . . . 27
3.7.2 Automatic Power On and Off . . . . . . . . . . . . . . . . . . . . . 27

3.8 Supplied and Optional Accessories . . . . . . . . . . . . . . . . . . . . . . 27
3.8.1 Standard Supplied Accessories . . . . . . . . . . . . . . . . . . . . 27
3.8.2 Optional Accessories . . . . . . . . . . . . . . . . . . . . . . . . 27

4 Installation 28
4.1 Site Selection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

4.1.1 Environmental Considerations . . . . . . . . . . . . . . . . . . . . . 28
4.1.2 Power Supply Considerations . . . . . . . . . . . . . . . . . . . . . 28
4.1.3 Communication Considerations . . . . . . . . . . . . . . . . . . . . 29

4.2 Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
4.2.1 Requirements for the Instrument Foundation . . . . . . . . . . . . . . . 29
4.2.2 Mounting the Instrument . . . . . . . . . . . . . . . . . . . . . . . 29
4.2.3 Orientation, Leveling and Calibration of the Sensor . . . . . . . . . . . . . 30
4.2.4 Installing other Components, Options, Accessories . . . . . . . . . . . . . 30

4.3 First Start and Communication Setup . . . . . . . . . . . . . . . . . . . . . 30

5 Quick Start Up 31
5.1 Preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
5.2 Set IP Address of the Instrument . . . . . . . . . . . . . . . . . . . . . . . 32
5.3 No Stations Configured at first Start Up . . . . . . . . . . . . . . . . . . . . 34
5.4 Adding New Stations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
5.5 Configuration of Data Server . . . . . . . . . . . . . . . . . . . . . . . . 35



4 / 150
GMSplus User Manual

2023-10-02 / V25

5.6 Basic Configuration of the Instrument . . . . . . . . . . . . . . . . . . . . . 37

6 Principle of Operation of the Instrument 40
6.1 Normal Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
6.2 Behaviour on a Seismic Event . . . . . . . . . . . . . . . . . . . . . . . . 41
6.3 Firmware and Configuration Upgrade . . . . . . . . . . . . . . . . . . . . . 43
6.4 Backup Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

7 Network Settings 44
7.1 Network Settings through the Web Interface. . . . . . . . . . . . . . . . . . . 44
7.2 Network Settings through GeoDAS . . . . . . . . . . . . . . . . . . . . . . 46
7.3 Wired Ethernet settings through the local Console . . . . . . . . . . . . . . . . 47
7.4 Wireless Settings through the local Console. . . . . . . . . . . . . . . . . . . 47
7.5 Get IP address from Instrument . . . . . . . . . . . . . . . . . . . . . . . 49

8 The Web Interface 50
8.1 Accessing the Web Interface . . . . . . . . . . . . . . . . . . . . . . . . 50
8.2 The Home Panel and the General Navigation . . . . . . . . . . . . . . . . . . 51
8.3 Device Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

8.3.1 Data Acquisition Configuration. . . . . . . . . . . . . . . . . . . . . 53
8.3.2 Configuration Manager . . . . . . . . . . . . . . . . . . . . . . . 54
8.3.3 Network Configuration. . . . . . . . . . . . . . . . . . . . . . . . 55
8.3.4 Web Interface Configuration . . . . . . . . . . . . . . . . . . . . . 56

8.4 State of Health . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4.1 Error Status . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4.2 Recording Status . . . . . . . . . . . . . . . . . . . . . . . . . 58
8.4.3 Hardware Status. . . . . . . . . . . . . . . . . . . . . . . . . . 59
8.4.4 Software Status . . . . . . . . . . . . . . . . . . . . . . . . . . 60
8.4.5 Maintenance . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

8.5 Data Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
8.6 Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

8.6.1 Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
8.6.2 Contact GeoSIG Service . . . . . . . . . . . . . . . . . . . . . . . 64

9 Detailed Configuration of the Instrument 65
9.1 Switch ON and OFF the Instrument . . . . . . . . . . . . . . . . . . . . . . 65
9.2 General Comments to the Configuration . . . . . . . . . . . . . . . . . . . . 65

9.2.1 Change Configuration by the Web Interface . . . . . . . . . . . . . . . . 65
9.2.2 Change Configuration by GeoDAS . . . . . . . . . . . . . . . . . . . 65
9.2.3 Changing Configuration by the Console . . . . . . . . . . . . . . . . . 66
9.2.4 Explanation of the Structure in the Manual . . . . . . . . . . . . . . . . 67

9.3 Configuration of the Channels . . . . . . . . . . . . . . . . . . . . . . . . 68
9.3.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 68
9.3.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 70
9.3.3 Calculation of the LSB factor . . . . . . . . . . . . . . . . . . . . . 73
9.3.4 Channel Naming. . . . . . . . . . . . . . . . . . . . . . . . . . 75

9.4 Configuration of Data Streams . . . . . . . . . . . . . . . . . . . . . . . 76
9.4.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 76
9.4.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 77
9.4.3 Set up of Data Streams . . . . . . . . . . . . . . . . . . . . . . . 79

9.5 Trigger Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
9.5.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 81
9.5.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 83
9.5.3 STA/LTA trigger . . . . . . . . . . . . . . . . . . . . . . . . . . 86
9.5.4 Trigger Weight . . . . . . . . . . . . . . . . . . . . . . . . . . 86
9.5.5 Trigger Time Frame. . . . . . . . . . . . . . . . . . . . . . . . . 86
9.5.6 Trigger Interconnection over LAN (example of 2 out of 3 stations logic) . . . . . . 89

9.6 Preset Trigger Settings . . . . . . . . . . . . . . . . . . . . . . . . . . 93
9.6.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 93
9.6.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 94



GMSplus User Manual
2023-10-02 / V25 5 / 150

9.7 File Storage and Policy . . . . . . . . . . . . . . . . . . . . . . . . . . 96
9.7.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 96
9.7.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 97

9.8 Communication Parameters . . . . . . . . . . . . . . . . . . . . . . . . 99
9.8.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 99
9.8.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 101
9.8.3 Connection over PPP (Cellular Modem or Analog Phone Line) . . . . . . . . . 104

9.9 Miscellaneous Parameters . . . . . . . . . . . . . . . . . . . . . . . . . 109
9.9.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 109
9.9.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 111
9.9.3 Time synchronization . . . . . . . . . . . . . . . . . . . . . . . . 118

9.10 Sensors and Virtual Channels . . . . . . . . . . . . . . . . . . . . . . . . 121
9.10.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 121
9.10.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 122

9.11 GeoSIG Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
9.11.1 In the Web Interface or by GeoDAS . . . . . . . . . . . . . . . . . . . 124
9.11.2 Via Local Serial Console . . . . . . . . . . . . . . . . . . . . . . . 125

9.12 Other Options in the Instrument Main Menu . . . . . . . . . . . . . . . . . . . 126
9.12.1 User Requests . . . . . . . . . . . . . . . . . . . . . . . . . . 127

10 Test and Configuration Menu 129
10.1 Flash Images and Boot Options . . . . . . . . . . . . . . . . . . . . . . . 131
10.2 Hardware Setup and Monitor . . . . . . . . . . . . . . . . . . . . . . . . 131
10.3 Test Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
10.4 Security . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
10.5 Comparison of User Permissions. . . . . . . . . . . . . . . . . . . . . . . 132

11 Firmware Upgrade 133

Appendices 135

Appendix A Connector Pinouts 136
A.1 POWER Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
A.2 ETHERNET Connector . . . . . . . . . . . . . . . . . . . . . . . . . . 136
A.3 SERIAL Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
A.4 GPS Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
A.5 SENSOR Connectors . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
A.6 INTERCONNECTION Connector. . . . . . . . . . . . . . . . . . . . . . . 137
A.7 MODEM Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
A.8 ALARM Connector . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Appendix B Remote Access to the Instrument over SSH 139
B.1 SSH Clients for Linux OS . . . . . . . . . . . . . . . . . . . . . . . . . 139
B.2 SSH Clients for Windows OS . . . . . . . . . . . . . . . . . . . . . . . . 140
B.3 SFTP access for Windows OS. . . . . . . . . . . . . . . . . . . . . . . . 141
B.4 File Structure of the Instrument . . . . . . . . . . . . . . . . . . . . . . . 142

Appendix C GeoDAS Settings 143
C.1 Configuration of Stations. . . . . . . . . . . . . . . . . . . . . . . . . . 143

C.1.1 Add a new Instrument . . . . . . . . . . . . . . . . . . . . . . . . 144
C.1.2 Remove an Instrument . . . . . . . . . . . . . . . . . . . . . . . 144

C.2 Configuration of Server Parameters . . . . . . . . . . . . . . . . . . . . . . 145
C.3 Instrument Control in GeoDAS . . . . . . . . . . . . . . . . . . . . . . . 146

C.3.1 More Information. . . (State of Health of the Instrument). . . . . . . . . . . . 146
C.3.2 Instrument Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . 147
C.3.3 Cancel Pending Request . . . . . . . . . . . . . . . . . . . . . . . 147
C.3.4 Instrument Communication Interface . . . . . . . . . . . . . . . . . . 147

C.4 Open recorded miniSEED files in GeoDAS . . . . . . . . . . . . . . . . . . . 148
C.4.1 Save predefined Scaling Factors . . . . . . . . . . . . . . . . . . . . 149
C.4.2 Calculation of the Scaling Factors . . . . . . . . . . . . . . . . . . . 150



6 / 150
GMSplus User Manual

2023-10-02 / V25

Table of Tables

1 Indicators description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2 Main battery specification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3 Main battery models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
4 Backup battery specification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
5 Backup battery models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
6 Storage instruction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

7 The overall error states shown in the Web Interface . . . . . . . . . . . . . . . . . . . . . . . . 51

8 Explanation table structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
9 Channel configuration menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
10 LSB of all GeoSIG sensors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
11 Data streaming configuration menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
12 Trigger settings configuration menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
13 Preset trigger configuration menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
14 File Storage and Policies menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
15 Communication Parameters menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
16 Miscellaneous Parameters menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
17 Time Synchronization Parameters Menu Structure . . . . . . . . . . . . . . . . . . . . . . . . 120
18 Sensor and Virtuals Parameters menu structure . . . . . . . . . . . . . . . . . . . . . . . . . 123
19 GeoSIG options menu structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
20 Other options in the main menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
21 User requests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

22 Comparison of test and configuration menu users . . . . . . . . . . . . . . . . . . . . . . . . . 132



GMSplus User Manual
2023-10-02 / V25 7 / 150

Applicability of This Manual

GMSplus Instruments are constantly being improved. Although the manual you receive along with your instru-
ment corresponds to the actual software versions, you are advised to check www.geosig.com periodically
for the most recent version of this document, and especially after performing any software upgrades. This
manual is based on the following software and firmware versions:

Component Description Required version or higher

GeoDAS Data acquisition and analysis software on the computer 2.28

armdas Data acquisition software of the instrument 21.12.25

RTC Real time clock 80.02.03

DSP Digital signal processor 51.03.05

U-Boot U-Boot bootloader 2013.01-r1

Web Interface Web Interface 1.12

Linux OS Root file system rootfs-gms-102

Kernel Version 2.6.39.4-r7

www.geosig.com
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Warnings and Safety

STATIC ELECTRICITY

The instrument and its sensor unit (if available) contain CMOS devices, and when serviced care must be
taken to prevent damage due to static electricity. This is very important to ensure long-term reliability
of the unit. Such risk exists when both the housing lid and the internal panel are removed.

INSIDE THE INSTRUMENT (MAINTENANCE)

When it is desired to fully restrict access to the unit so that even its housing lid cannot be removed,
lockers can be mounted in the middle of the handles, on the side of the instrument. Under normal
circumstances there is no need to remove the internal panel of the instrument. In any case, only a
trained person should remove the front panel or the cover. Moreover untrained access may lead to
serious damage to the instrument, and may void the warranty. If the equipment is used in a manner
not specified by the manufacturer, the protection provided by the equipment may be impaired.
Before removing the internal panel:

1. Turn the unit off

2. Disconnect all cables connected to the unit

3. Disconnect the battery

4. Make sure that all LED indicators are OFF

INSTALLATION SITE

This instrument is designed for highly specialized applications. If installed in publicly accessible areas
it is the responsibility of the instrument owner to ensure that the device is installed in a safe and secure
manner.

The instrument should be installed in a well ventilated place and when possible be protected from
direct sunlight and heat.

The housing provides no protection against explosive atmosphere. The instrument must not be oper-
ated without necessary protective measures (e.g. EX-proof housing) in an area where explosive gases
could be present.

BATTERY (MAINTENANCE) AND SAFETY

The instrument is usually shipped with an internal rechargeable battery (main battery), which is an
optional accessory.

In addition there is a non-rechargeable button battery (backup battery) on the circuit board of the
instrument.

NEVER use any battery other than the ones supplied or approved in writing by GeoSIG.

An external power module, which is an optional accessory, is also usually shipped with the instrument.

NEVER use any other power module than the one supplied or approved in writing by
GeoSIG.

Do not forget to connect the main battery when installing the instrument. The main battery is provided
with a short cable that has a polarised connector to avoid any wrong connections. Please ensure that
this connector is fully inserted and secured on the mating connector inside the instrument.



GMSplus User Manual
2023-10-02 / V25 9 / 150

CAREFULLY observe the polarity,

when replacing the main battery:
RED cable = (+) plus terminal of the battery
BLACK cable = (-) minus terminal of the battery

when replacing the button backup battery:
(+) sign marked on the battery

Battery Battery model Replacement interval
Main Battery (Internal) FIAMM FG20721, 12V 7.2Ah 3 years from date of production1

Yuasa NP7-12, 12V 7Ah 3 years from date of production1

FIAMM 12FGHL34, 12V 9Ah (long life) 8 years from date of production1

Button Backup Battery Renata CR2430 MFR, 3V, 285mAh 5 years from date of production1

Duracell CR2430, 3V, 285mAh 5 years from date of production1

EEMB CR2430, 3V, 270mAh 5 years from date of production1

1assuming operation at a steady 20°C or below

The expected lifetime of a battery can drastically change depending on operating conditions. Strong
discharge of the battery and extreme temperatures must be avoided as per specific battery manufac-
turer’s recommendations and guidelines.

Lifetime and replacement intervals mentioned in this manual are based on a constant ambient temper-
ature of 20°C or below. If this condition cannot be met the user must check with the documentation of
the battery manufacturer for information about the battery lifetime at elevated temperatures.

When replacing the battery only newly manufactured batteries may be installed. The replacement
interval specified above starts from the manufacturing date of the battery, which is typically found
printed on the battery itself. When replacing the battery it is the users’ responsibility to update the
"battery installation dates" parameter in the configuration as described in chapter 10.2. This parameter
is used to issue a warning of required battery change.

For safety reasons the battery and operating conditions have to be checked annually to ensure that
they are still within the manufacturer’s recommended operational criteria.

It is important that all necessary precautions about operating a battery, such as the ones installed in
the instrument, are taken into consideration and the safety instructions are followed accordingly.

Lack of care or misuse of the battery as per battery manufacturer’s recommendations can be haz-
ardous, may damage your instrument and may even cause explosions. Please consult the battery
manufacturer’s website for the latest operating, maintenance and safety guidelines. Please contact
GeoSIG in writing if the specific safety, operating, maintenance and disposal information for your bat-
tery type can’t be found.

The internal main battery (if installed) is a Lead Acid-type battery and is classified as
"dangerous waste". The user is obliged to follow local laws and manufacturer’s guide-
lines for safe use and correct disposal of any battery.

SD AND COMPACT FLASH CARDS

SD and compact flash cards are available in a variety of quality levels on the market. This results in
problems with compatibility due to memory layout, signal structuring and power requirements. Ad-
ditionally some SD and compact flash card manufacturers refuse to provide adequate information or
factory controls to ensure that the product being sold today is the same as the product sold earlier
under the same part number.

Therefore GeoSIG cannot guarantee a SD or compact flash card will work in a GeoSIG instrument
unless it is purchased through GeoSIG. The SD and compact flash cards provided by GeoSIG are
tested and certified in-house to work with the related GeoSIG instrument and are industrial rated for
harsh environment conditions such as extreme temperatures, shock, and vibration.
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CLEANING

Disconnect the power from the instrument prior to cleaning. Do not remove the housing lid during
cleaning. Wipe all exterior surfaces with a damp cloth. Use mild detergent if required. No water should
be used if cleaning inside the instrument is required.

HOUSING LID

In case your instrument does not have a lid with holes as described in chapter 3.2 you must contact
GeoSIG to order a replacement lid.
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GeoSIG Cybersecurity Recommendations

GeoSIG instruments, as described in their documentation, have built-in security and safety features against
unauthorised access or use. However, ultimately it is the user’s responsibility to ensure the safe and secure
usage of our instruments based on their actual implementation. No factory delivered solution can fit each and
every possible scenario. The user is advised herein that once you connect a device to a network, you are also
connecting that network to that device. It is the responsibility of the user to take appropriate precautions so that
all devices should be adequately hardened, such as with individual strong passwords, and should have their
traffic monitored and managed via appropriate security features, such as firewalls. Also, non-critical devices
should be segmented away from networks that contain sensitive information.

Compliance with a well-defined security procedure helps protect not only an individual device, but also other
devices connected through the network. Such procedure would be intended to prevent exploitation of an
individual device’s resources by unauthorized individuals, including the use of such device to attack other
systems on the network or the Internet.

The following recommendations can be considered in establishing such a security procedure:

1. Physical access restriction

All devices must be restricted from unauthorised physical access and a well-defined physical access
procedure shall be utilised.

2. No Unattended Console Sessions

Except for the devices which are physically secured, no unattended console sessions shall be left running.

3. No Unattended Network Sessions

No unattended user interface sessions shall be left running towards any device accessed through its
network interface.

4. Use of a Firewall

For a network that has any connection to the outside world, a hardware firewall must be running and
configured to block all inbound traffic that is not explicitly required for the intended use of the network and
the connected devices. The user can also consider limiting outbound traffic.

Any communication ports that are required for the operation must be protected.

5. No Unnecessary Services or Ports

If a service or port is not necessary for the intended purpose or operation of the device, that service must
not be running and the port must be closed. (e.g. if seedlink server is running, but not used, turn it off)

6. Use of authentication

Network and console device access must require authentication by means of strong and individualised
passwords per device (no passe-partout passwords).

Wireless access must require strong encryption to associate (such as WPA2), or some other strong
mechanism to keep casual users near the access point from using it to get full access to the network.
WEP or MAC address restrictions do not meet this requirement.

7. Password complexity and security

When passwords are used, they must meet the specifications similar to below:

All default passwords must be changed at time of initial access or latest at deployment
into service.

Passwords MUST:

contain eight characters or more
contain characters from AT LEAST two of the following three character classes:

Alphabetic (e.g., a-z, A-Z)
Numeric (i.e. 0-9)
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Punctuation and other characters (e.g., !@#$%^&*()_+|~-=\‘{}[]:";’<>?,./)

8. Privileged Accounts

Privileged and super-user accounts (Administrator, root, etc.) must not be used for non-administrator
activities. A secure mechanism to escalate privileges with a standard account is acceptable to meet this
requirement. Network services must run under accounts assigned the minimum necessary privileges.

9. No Unencrypted Authentication

All network-based authentication must be strongly encrypted. In particular, insecure services such as
Telnet, FTP, SNMP, POP, and IMAP must not be used or must be replaced by their encrypted equivalents.

10. Software / Firmware updates

Networked devices must only run software/firmware that are updated according to supplier’s guidelines.
A periodical check of any available updates from the supplier must be sought.

Please contact GeoSIG Ltd if you require any further advice or clarification.
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Symbols and Abbreviations

ADC Analog to Digital Converter
ARM Main processor
armdas GeoSIG data acquisition software
Bootloader First program executed when unit starts
CF Compact Flash, memory card using Flash memory
Compact Flash See CF
DSP Digital Signal Processor in charge of controlling the ADCs
GSIAFW GeoSIG data acquisition software.
EEW Earthquake Early Warning
Flash Program storage memory device. It contains the Linux file system in Read Only

mode and some block areas under direct control of main program or bootloader
FTP File Transfer Protocol
GPS Global Positioning System
GUI Graphical User Interface
IMAP Internet Message Access Protocol
LAN Local Area Network, a simple branch of private network using private IP address.

It could have or not have access to Internet (WAN)
NTP Network Time Protocol
POP Post Office Protocol
PPS Pulse Per Second
RAM Random Access Memory
RTC Real Time Clock
SD Secure Digital Memory Card
SNMP Simple Network Management Protocol
SPS Samples Per Second
SSH Secure Shell
SSID Service Set Identifier. This is the identifier name of a wireless network.
STP Shielded Twisted Pair
SUP Supervisor in charge of controlling the power management.
Telnet Teletype network
USB Universal Serial Bus
UTP Unshielded Twisted Pair
VPN Virtual Private Network
WAN Wide Area Network. It is a network connection established between 2 LAN or a

LAN and a server over the internet (usual case) or through a rented link.
WPA Wi-Fi Protected Access. It is a secure specification that allows users to access

information instantly via wireless link. It is a more modern and secure link than the
WEP type.

WEP Wired Equivalent Privacy
Important information related to the current section.

Caution. Refer to the instructions next to the marking, or refer to the relevant section
of this user manual.
Direct current. This symbol indicates a direct current (DC) power line derived from
an alternating current (AC) power source.

Earth terminal.

CE. This symbol indicates that the device conforms to all legal requirements
needed to achieve free movement and sale of the product through the European
Economic Area (EEA).
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1 Introduction

Dear Valued GeoSIG Customer, thank you for purchasing this product.

These instruments have been optimised to meet the requirements of the majority of customers out of the box
and may have even been delivered tailored to your needs. In any case, to be able to get the most out of
our product, please carefully study this manual, its appendices and referenced manuals, as well as any other
documents delivered with it.

This is a reliable and easy-to-use device, and at the same time a sophisticated product that requires care,
attention and know-how in configuring, installing, operating and maintaining.

GeoSIG continually improves and enhances capabilities of all products. There may be several other connec-
tivity, hardware or software options for the instrument, which are not covered in this manual. Refer to separate
documentation from GeoSIG about available options or ask GeoSIG directly.
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2 Incoming Inspection

All instruments are carefully inspected both electrically and mechanically before they leave the factory. Please
check if all received items correspond with the packing list and your order confirmation. In case of discrepancy
please contact GeoSIG or your local representative immediately.

2.1 Damage During Shipment

If requested at the time of order, all instruments can be insured prior to shipment. If you receive a damaged
shipment and shipping insurance was previously arranged you should:

• Report the damage to your shipper immediately

• Inform GeoSIG or your local representative immediately

• Keep all packaging and shipping documents

Insurance claims may be void if the above procedure is not followed.

2.2 Warranty

GeoSIG Ltd (hereafter GeoSIG) warrants hardware and software products against defects in materials, work-
manship and design for the defined period in the relevant contract or offer, starting from date of shipment and
5 years parts and maintenance support commitment. If GeoSIG receives notice of such defects during the
warranty period, GeoSIG shall at its option either repair (at factory) or replace free of charge hardware and
software products that prove to be defective. If GeoSIG is unable—within a reasonable time—to repair or re-
place any cabinet to a condition as warranted, buyer shall be entitled to a refund of the purchase price upon
return of the cabinet to GeoSIG. 50% of freight charges on shipments of warranty repairs or replacements will
be borne by GeoSIG (normally one way freight).

2.2.1 Limitation of Warranty

The foregoing guarantee shall not apply to defects resulting from:

• Improper or inadequate maintenance by buyer

• Buyer supplied software or interfacing

• Unauthorised modification or misuse

• Operation and storage outside of the environmental specifications of the instrument

• Related to consumables or batteries

• Improper preparation and installation at site.
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3 Description

3.1 Housing

The instrument is a housing mounted with a base plate. The base plate is fixed on ground and leveled one
time during installation, then the instrument can be replaced without need for leveling.

Figure 1: Instrument overview 1

3.2 Housing Lid

If your instrument has been supplied with an internal Lead Acid battery (main battery), the housing lid will
have two ventilation holes that are covered by special membrane vents, as shown in Figure 2. A Lead Acid
battery as a matter of course will release small amounts of hydrogen which could cause an explosion under
certain conditions. A typical GMSplus housing will allow hydrogen to escape through various small openings in
the housing, however as an extra level of safety, precautionary measures have been taken by providing two
ventilation holes to allow additional air circulation within the housing. The specially applied membrane vents
will prevent external matter from entering the housing while allowing air circulation through specially designed
PolyVent membranes as shown.

Please ensure that the vents are not covered and that the instrument is not placed in a confined area without
adequate ventilation. GeoSIG will not accept any responsibility for the safe operation of the battery or any
safety-related consequences that may result from using the battery.

Please consult GeoSIG in writing if you have any specific questions or require clarification with regards to use
of the battery in the instrument.

1Connectors may vary depending on ordered configuration
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Outside view
Inside view

Figure 2: Housing lid ventilation holes

3.3 Base Plate

A base plate is supplied with the instrument for fixation and leveling of instrument on site. Three leveling feet
are provided to adjust horizontally the base plate. The fixation is done as a single point in the middle of the
plate.

To ensure correct orientation when an instrument is installed on the plate, two pins are provided with the plate.
They can be mounted in different positions according to the orientation required and will fit in the two holes
existing in the base of the instrument.

A connection point for earthing is also provided with the plate as an M6 thread.

See chapter 4.2.2 for details about how to fix the base plate on the ground.

Figure 3: Instrument base plate
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3.4 Connectors

The instrument has up to nine connectors and two antenna plugs:

Figure 4: Instrument with all connectors. Antennas are not mounted 2

See Appendix A for the detailed pinout description of the connectors.

3.4.1 Standard External Connectors

These connectors always will be assembled:

POWER Connection to the power supply module of the instrument or to an external battery.

ETHERNET Connection with Ethernet cable to a LAN. The cable connection is dominant over the Wi-
Fi link. As soon as the cable connector is plugged in the instrument ETHERNET socket,
the Wi-Fi module will be turned off, even if the RJ45 connector at the end of the cable is
not plugged into any socket.

SERIAL Connection to the console or for the serial data stream output, depending on the cable
type. Optionally also the cellular modem can be connected to this port.

GPS For connection to a GPS receiver.

3.4.2 Optional External Connectors

These connectors depend on the ordered options:

SENSOR1 Connection to an external sensor.
SENSOR2 Connection to a second external sensor in case of a six channel instrument with

two external sensors.
INTERCON Connection to the interconnection network allowing common time and common

triggering.
MODEM Connection to analog phone line for the internal analog modem.
ALARM Contacts of the internal alarm relays.

2Connectors may vary depending on ordered configuration
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3.4.3 Optional External Antennas

Wi-Fi Antenna connector for the wireless Internet.

WiSync Antenna connector for 433 MHz synchronisation, allowing time synchronisation of sev-
eral instruments wirelessly.

3.4.4 Connectivity Options

A large variety of options can be connected to the instrument. The following figure should give an overview of
the main possibilities. Ask GeoSIG for details about any specific connectivity options.
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Figure 5: Connectivity options

3.4.5 Internal Connector

The instrument is equipped with an internal RS-232 connector giving access to the console. A standard RS-
232 extension cable (straight, female-male) can be used to connect to a computer.

Figure 6: Internal RS-232 connector for the console

3.5 Visual Indicators

Several visual indicators (LEDs) show the status of the instrument.
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Figure 7: Visual indicators on the housing lid (left) and on the internal panel of the instrument (right)

Indicators, from left to right:

Colour Indication States
GREEN AC

indicator
When ON, the external power supply is present

GREEN RUN
indicator

OFF: the unit is off

Blinking 20% ON, 80% OFF at 2 sec period: The instrument is
starting up or the data acquisition program has been stopped or is
not running

Blinking 20% ON, 80% OFF at 1 sec period: Normal operation
of the instrument, data acquisition is running

Blinking 80% ON, 20% OFF at 2 sec period: Instrument is shut-
ting down, data acquisition is not running and the instrument will
be powered down soon

YELLOW EVENT
indicator

OFF: Unit is not recording and no events are on the CF card

Blinking: Indicates the amount of memory used on the CF card
(<25%, >25%, >50%, >75%)

ON: The unit is recording
BLUE LINK

indicator
OFF: Link with the data server is established, no communication
ongoing

Blinking at 1 sec period: Problem with the link to the data server

ON: Link with the data server is established, communication or
data transfer ongoing

RED ERROR / STATE
indicator

OFF: No problem or warning

Blinking at 2 sec period: Warning is present

Blinking at 1 sec period: Error is present

ON: Data acquisition is not running, e.g. during start up

Table 1: Indicators description
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3.5.1 Detail Description
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3.6 Internal Batteries

3.6.1 Main Battery

The safety instructions given in Warnings and Safety must be strictly followed.
Following the safety instructions helps to reduce risk of fire, electric shock, personal
injury and material damage.

If installed, the battery is used in the instrument to power it in case of external power loss. If the external power
is not restored when the battery reaches a low level, the unit will switch off by itself to avoid deep discharge
of the battery. This protects the battery against capacity reduction or destruction occurring usually in case of
deep discharge for such battery type. The battery has the following specifications:

Description Specification

Nominal Voltage 12 V

Capacity 7.2 Ah

Length 153 mm

Width 66 mm

Height 96 mm

Overall height 102 mm

Weight 2.65 kg

Connection Faston 6.3

Table 2: Main battery specification

The following models have been checked to be compatible with the instrument:

Supplier Model

FIAMM FG20721

Yuasa NP7-12

Table 3: Main battery models

3.6.2 Backup Battery

The backup battery is used to maintain time in the instrument when it is powered off. It requires the following
specifications:

Description Specification

Nominal Voltage 3 V

Capacity 285 mAh / 270 mAh

Cell diameter 24.5 mm

Cell height 3 mm

Weight 4.1 g

Table 4: Backup battery specification
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The following models have been checked to be compatible with the instrument:

Supplier Model

Renata CR2430 MFR

Duracell CR2430

EEMB CR2430

Table 5: Backup battery models

3.6.3 Storage (Instrument Shelf Life)

In case the instrument is stored, the batteries have to be maintained according to the storage duration.

Period of time External power
supply

Instrument is
operating Main battery Real Time Clock

backup battery

< 1 month
ON YES Connected Connected
ON NO Connected Connected
OFF NO Connected Connected

1 - 3 months
ON YES Connected Connected
ON NO Connected Connected
OFF NO Disconnected Connected

3 - 6 months
ON YES Connected Connected
ON NO Connected Disconnected
OFF NO Disconnected Disconnected

More than 6
months

ON YES Connected Connected
ON NO Connected Disconnected

OFF NO

Disconnected, must be
recharged every 6

months for at least 24
hours.

Disconnected

Table 6: Storage instruction

Removing or replacing the backup battery must be done by a trained person only. Therefore if the instrument
is stored for more than three months, always have it connected to power and let it run.

If the instrument is stored for longer than 3 months, the battery must be removed from the instrument and
stored elsewhere in a well ventilated location as per the battery manufacturer’s recommendations. The battery
must, in this case, be charged every six months for at least 24 hours.

If the instrument is connected to AC power through its power supply module while stored, the main battery (if
it exists) can remain in the unit. It is highly recommended to ventilate the stored instrument by removing the lid
of the instrument.

Current leakage on main battery when unit is off, without external supply, is about 40µA.

Autonomy of Real Time Clock on its backup battery is typically three years at ambient temperature. The jumper
JMP_BBATT on the main board has to be put in position 2-3 to disconnect this backup battery. This must be
done by a trained person. The removal of the internal panel is required.

Figure 13: Position of JMP_BBATT
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3.7 Power Supply

3.7.1 Choice of Power Supply

The main power should be provided to the instrument from a 15 VDC supply. The optional AC/DC power
module provides 15 VDC at 1.2 A unless otherwise specified. The AC entry is compatible with 110 / 60 Hz or
230 / 50 Hz network without any adjustment. The block has a C7 connector and can use any standard power
cord with such connector. The power module and the power cord supplied are both CE and UL approved. The
power module must be connected to AC with a 2-wire power cable providing Phase and Neutral.

Figure 14: Power supply

Optionally the instrument can be built to have a 9 to 36 VDC input voltage range. This option must be specified
at order time.

3.7.2 Automatic Power On and Off

The instrument has a defined minimum start-up voltage of 12.5 VDC and will automatically make a controlled
power down if the supply voltage goes below 10.6 VDC.

3.8 Supplied and Optional Accessories

3.8.1 Standard Supplied Accessories

The following parts will be included in a shipment additional to the instrument:

• Fixation base plate with leveling feet

• Screw and anchor bolt for fixation

• Ethernet cable, category 5 cable for 10/100 Mbit network with a suitable connector for the instrument, 5
meters of cable and a standard RJ45 connector. Other cable lengths are available by request.

3.8.2 Optional Accessories

The following parts can be ordered additionally and will be added if specified at order time:

• External power supply module, 100 to 230 VAC / 50-60 Hz, CE and UL approved

• AC power cable, depending on the shipping address with European, US or Swiss power plug

• GPS time code receiver with 20 meter cable, other cable length on request. GPS is an option as the time
can also be synchronised through the network using NTP

• Console cable for use on the external SERIAL connector

• Data stream cable for use on the external SERIAL connector

• SD/CF card reader for USB for reading the memory card on a computer or laptop

• Cellular modem

• Any spare connectors

• Any spare antennas

• Spare battery
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4 Installation

This section lists the procedures involved in installation of the instrument. The procedures will be outlined as
steps to be performed in the field or in-house prior to deploying the instrument in the field.

4.1 Site Selection

4.1.1 Environmental Considerations

The choice of an installation site for a seismic event recorder is similar in most respects to that of a regular
continuous recording seismic station.

Although the instrument is housed in a solid, weatherproof case, it should be installed in a place free from
direct sunlight, precipitation, the danger of falling materials in the event of a severe earthquake and the risk of
tampering or vandalism if the unit is to be left unattended.

There are also special considerations for event recorder installations. It is important to select the site and set
the trigger level to avoid unwanted data recording, such as vibration from machinery, highway traffic, aircraft,
waves, etc. It is wise to check the instrument frequently during the first several days of operation after each
set-up, to see if there are previously unsuspected sources of noise which are triggering the instrument and
using up the memory.

In addition, the user should select a site with a provision for 115 / 230 VAC power if the unit will be left in place
for a long period of time (more than 26 hours). Although this is not necessary for the operation of the device, it
does preclude concerns about battery charging.

You should make note at this point of any cultural or environmental sources of noise and vibration around the
selected site, which may cause false triggers of the recording mechanism. These will have to be considered
when setting the trigger parameters.

The operating temperature of the instrument itself is -20°C to +70°C. Nevertheless, if any additional internal
or external accessories/modules (e.g. batteries, sensors, modems, etc) with lower operating temperature
ranges are used, the operating temperature of the combined system will be then limited by the temperature
characteristics of these accessories/modules.

4.1.2 Power Supply Considerations

The instrument may be powered from a 115 / 230 VAC supply through an external AC/DC converter, from an
internal or external battery, or optionally from a 15 VDC external supply such as an automotive battery or solar
panels. It can also be powered from an external DC power supply from 9 to 36 VDC (any of these options must
be specified at order time).

• If the supply in the field will be from a 115 / 230 VAC supply, you need to connect the VAC cable from
the external AC/DC to the power source only. The instrument operates continuously, providing a trickle
charge to the internal battery, if supplied. The VAC supply must consist of Phase and Neutral.

• If the supply in the field will be from a 9 to 36 VDC supply (optional), you need to connect the power
cable from instrument to the power source only. The instrument operates continuously, providing a trickle
charge to the internal battery, if supplied.

• If the instrument is running from an external battery (optional), you need to connect the delivered battery
cable from instrument to the power source only. In this case there should be no internal battery installed.
The external battery must be charged with an external battery charger.

• If the supply will be exclusively from the instrument’s internal battery, it is necessary to charge the battery
sufficiently beforehand. Make sure to have at least 24 hours of uninterrupted charging prior to leaving
the instrument in the field. The configuration of the instrument, of course, may be performed while the
charger is connected to the instrument. The external AC/DC converter has to be plugged to 115 / 230
VAC for charging the internal battery.

The best approach to the deployment of the instrument is to use an internal battery along with the VAC/VDC
power at the remote site. It is highly recommended to check and configure the instrument for the correct time,
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trigger and other relevant settings in the lab, prior to the installation (see chapter 5). It may then be carried to
the remote site (it should be switched OFF to conserve the internal battery) and then connected to the VAC
power through the external AC/DC converter or directly to the VDC power supply. After turning the instrument
ON (see chapter 9.1), the instrument runs with the pre-configured parameters. This reduces the amount of
time needed to configure in the field – an important consideration in the case of an adverse condition.

4.1.3 Communication Considerations

An Ethernet connection or Wi-Fi signal must be present to have data communication. If the instrument uses an
NTP Server as time source, please make sure that an internet connection is available and the network settings
are properly set in the instrument. Optionally an external cellular modem can be used for the connection to
the internet. Use of NTP is not recommended when using a cellular modem; a GPS should be used instead if
possible.

If the instrument is used as a stand-alone recording station, a notebook with an Ethernet connector can be used
for downloading the data on a regular basis. In a network the stations will upload the data to the configured
server.

4.2 Installation

For your convenience a training video explaining the installation of the instrument is available at
www.geosig.com→ Support→ ’How To . . . ’ Videos

Many times the locations of seismic equipment are highly exposed to electrical disturbances caused
by lightning or by the industrial environment. Although the instrument contains over-voltage protec-
tion, it may sometimes be necessary to use additional surge protectors for the equipment. Contact
GeoSIG or your local representative for more information.

Typically it is required to connect the base plate to the local earth to avoid or minimise 50/60 Hz
distortions in the signal by surrounding power lines. Use the provided M6 earth screw and make
sure to have a proper connection by using only short cables with large diameters.

4.2.1 Requirements for the Instrument Foundation

Minimum surface area requirements

• with internal sensor: 30 x 26 cm

• with external sensor (excluding area of sensor itself): 30 x 30 cm

4.2.2 Mounting the Instrument

The unit must be fixed rigidly on the building foundation; it has a base plate that must be first fixed on the
ground and then the instrument mounted on it. For that purpose, the base plate has a central fixation hole
(suitable for 8 mm screws) and three leveling screws. Prepare the base plate (see also Figure 15):

• Mount the three leveling screws (D).

• Check that the four M6 threads for the instrument fixation are free from dust.

• Mount the two polarization pins on the base plate on the side where the connectors will be (E/F).

Place the base plate at the selected location. Verify that the surface is sufficiently flat and horizontal so that the
three feet can level the plate. Be sure to leave enough space at the front of the instrument for the connectors
and for opening the housing lid. The sides of the instrument should typically not be closer than 100 mm (4
inches) from a wall. Mark on the ground the location of the central hole in the plate. Remove the base plate.

The instrument itself can be mounted in any orientation desired under the condition that it does not have an
internal battery. In cases where the instrument has an internal battery it must always be mounted flat on the
ground in a non-tilted position. If the installation requires both a battery and a tilted, wall- or ceiling-mounted
instrument, the battery must be placed externally.

Drill an 11 mm hole in the concrete with a typical depth of 50 mm for the supplied M8 concrete anchor (C).
If another model is used, please adapt the hole dimensions accordingly. Clean the hole area of dust. Insert
the concrete anchor into the hole. Mount the plate in place and insert the M8 fixation screw (A/B) in its hole.
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Figure 15: Installation of the base plate

Turn the plate so it is oriented according to requirement. Make a coarse leveling of the plate (D). Start fixing
the plate by tightening the M8 central screw (A). Check regularly the plate orientation and level until the plate
is rigidly fixed (D). Remove the housing lid of the instrument and put it on the mounting plate using the four
screws and washers to fix it. With all GMS-type housing, the base plate is leveled to 0.8Nm evenly on each
screw. Take care about the two orientation pins on the plate (E/F).

Do not over tighten the leveling screws.
Do not cause any short circuit on the battery poles or inside the unit.
Connect the base plate to the local protection earth.

4.2.3 Orientation, Leveling and Calibration of the Sensor

Check it is really fixed by pushing from all directions. If you feel any movement, recheck the fixation.

Internal Sensor: The sensor is located under the internal panel. Since no setup is required for the sensor,
there is no need to remove the internal panel. The leveling is done on the base plate, and the sensor is already
configured to operate with the recorder.

Nevertheless for most applications it is important that the internal sensor is aligned according to the require-
ments. This can be done using the axes label on the wall of the instrument. In case the axes shall be aligned
according to the global coordinate system, the Y-axis must point direction north. So X-axis corresponds then
to East-West, Y-axis to North-South and Z-axis to Up-Down.

External Sensor: Mount and level the sensor according to its manual and connect to the external sensor of
the instrument. There is no need to align the instrument to a certain direction. All standard sensor housing
should be leveled to 0.6Nm evenly on each screw.

4.2.4 Installing other Components, Options, Accessories

For installation of other components, options, or accessories please refer to the specified option manual.

4.3 First Start and Communication Setup

With the instrument correctly fixed on the ground through the fixation plate please proceed with chapter 5 for
the first start-up and configuration.
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5 Quick Start Up

This chapter is intended to configure simple communication between the instrument and GeoDAS software
running on a Windows workstation, working as data server.

It is assumed that the GeoDAS software is already installed on a computer. If not, please do the
installation first with help of the GeoDAS User Manual before proceeding.

5.1 Preparation

• Make sure the instrument is powered by the provided power supply. Remove the instrument housing lid
using the four screws on the top corners.The green AC indicator should be ON.

• Make sure the instrument is connected to a LAN by the supplied Ethernet cable.

• If installed, verify that the battery is correctly fixed and connected to the system.

In case there is no LAN available, the Ethernet cable can be connected directly to a computer. For
this a crossed Ethernet cable is needed; please contact GeoSIG. Nevertheless in modern comput-
ers normally it works as well with the supplied patch cable.
In any case the instrument and the computer must be configured to have a fixed IP. Please follow
the procedure to adjust these settings.

• Connect the instrument to a serial port of your computer by using a standard RS-232 patch cable.

• Open any terminal program and choose the appropriate COM port. Baud rate is 115200. Alternatively
open GeoDAS, go to Tools → Terminal . . . and choose the COM Port. As Baud rate select 115200.
Then Press Connect

Figure 16: GeoDAS terminal

• Keep the terminal open for the next step.

https://www.geosig.com/files//GS_GeoDAS_UserManual.pdf


32 / 150
GMSplus User Manual

2023-10-02 / V25

5.2 Set IP Address of the Instrument

Network settings of the instrument can be changed during startup of the instrument. By default the instrument
has a dynamic IP.

• If the instrument is on and running, send the command to reboot the instrument, otherwise switch on the
instrument (See chapter 9.1).

• Press ‘Ctr + Z’ as soon the following message appears on the console to enter the test mode.

#################################################
###### Test and Initial Configuration Mode ######
#################################################
Press Ctrl+Z to enter the test mode.....

The following menu will appear (see chapter 10 for details):

--------------------------------------------------------------------------------------
Level Shortcut Password Description
--------------------------------------------------------------------------------------
User Ctrl+U None Basic operations only
Powerful User Ctrl+W None Also hardware options and pre-selected tests
Administrator Ctrl+A None Also manual tests and altering the FLASH memory content
--------------------------------------------------------------------------------------
Your level [U/W/A] or press B to boot now:

• By default no passwords are set, so press ‘U’ to enter the User Mode, and then ‘N’ to enter the menu
Network settings.

==== Network Settings ====

---- Primary network interface ----
Configure network interface (Y/N)? Y
Static IP address (1=YES, 0=AUTO)? (0 = 0x0):

• Select ‘Y’ to change the settings and then select if the instrument should have a static or a dynamic IP by
pressing ‘1’ (Static) or ‘0’ (dynamic). In case a dynamic IP is chosen, a DHCP server must be available
in the network to provide the IP settings.

• In case a static IP is selected, an additional message will appear asking for the instrument IP address,
instrument network mask and instrument gateway IP. If you don’t know these parameters please ask your
network administrator.

• If the instrument has a Wi-Fi module, a second interface menu appears. Here static or dynamic IP can
be chosen and the available Wi-Fi networks can be scanned. Please see chapter 7.4 for details.

---- Wireless network interface ----
Configure network interface (Y/N)? Y
Static IP address (1=YES, 0=AUTO)?

• If the instrument is connected to the Internet via a PPP connection (cellular or analog modem), then the
APN and password must be configured. See chapter 7.4 for details.

---- PPP Communication ----
Edit Analog Modem settings (Y/N)? Y
Phone number of the service provider [T313001]:
Login [demo]:
Password [demo]:
Updating configuration...
PPP settings have been updated
Edit Cell Modem settings (Y/N)? N

• The instrument allows access to the operating system from remote over SSH. This feature is not needed
for normal operation of the instrument and can be disabled in case of security concerns. By default it is
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enabled; to disable press ‘1’.

---- Miscellaneous parameters ----
Disable remote login over ssh (1=Yes, 0=Enable)? (0 = 0x0):

• It’s highly recommended to put a recovery server IP address and recovery server port. The instrument
will contact this server every Recovery server contact interval in case the connection to the main data
server (configured in the configuration of the instrument) is not possible anymore. This could happen, for
example, if a configuration file with wrong server settings were accidentally uploaded to an instrument.

Recovery server IP address (192.168.10.107):
Recovery server port (3456 = 0xD80):
Recovery server contact interval, hours (24 = 0x18):

• As soon the following menu appears, press ‘5’ to start the instrument.

Access level: User

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
N - Network settings

--- Security ---
O - Set password

-->

• Start GeoDAS (if not already done), to add the instrument in its configuration
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5.3 No Stations Configured at first Start Up

The following steps require GeoDAS version 2.24 or higher. If you have an older version download
the newest release from www.geosig.com → Support → Downloads

• When GeoDAS is started for the first time, it will ask to add stations in its configuration.

• Click Yes

Figure 17: "No stations configured" message at startup of GeoDAS

If there are already stations configured in GeoDAS, this window will not appear. Please press the

wizard button in the GeoDAS menu

An exported GeoDAS configuration is in the USB stick that gets shipped with the instrument

5.4 Adding New Stations . . .

Make sure the computer is connected to the same network as the instrument and in the same IP
range.

• In the following window, select My instrument other than GSR is connected to the local network and
press Next >

Figure 18: Instrument wizard

• Enter the Serial number of the instrument and press Login >. It is also possible to add more than one
station by entering only a fragment of the serial number which is similar on all instruments. For example
if there are the serial numbers 100210, 100211 and 100234. By entering ’1002’ all the stations will be
added. By putting ’10021’ just the stations 100210, 100211 will be added.
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Figure 19: Quick Login Window

• All the found stations will be listed, press Finish to add them to GeoDAS

Figure 20: List of all stations found - single station left, multi-selection right side

5.5 Configuration of Data Server

• Proceed to the menu Settings → Configure Stations . . .

• The following window will appear where all the instruments are listed in the area 1. To add stations make
a right click and choose Add Station to current configuration. Please see chapter C.1 for details.

Figure 21: Configuration and overview of the stations
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• Press the button Server. . . When the window below appears, enter the following data:

▪ My server IP address IP of your computer
▪ Server port Select a user defined port, use 3456 by default

Figure 22: Data server parameter

In most cases you do not need to enter an IP address. It may only be needed if your computer has
several network cards, and you would like to communicate to instruments connected only to one
subnetwork. Otherwise you may leave the default zero IP address 0.0.0.0
If you don’t know how to find out your IP address, follow these steps:
- Click Start → Run → type cmd, then press OK

- Enter the command ‘ipconfig’, then your IP appears

Ethernet adapter Local Area Connection:
Connection-specific DNS Suffix . :
IP Address. . . . . . . . . . . . : 192.168.10.107
Subnet Mask . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . : 192.168.10.254

- Type exit

• Write down the IP and port you have configured

• Press OK two times to exit again to the main window of GeoDAS



GMSplus User Manual
2023-10-02 / V25 37 / 150

5.6 Basic Configuration of the Instrument

• In the window Stations: General Information make a right click on the station name and select Instru-
ment Setup. . .

Figure 23: Instrument setup

• A window showing the Web Interface will appear.

Figure 24: Web Interface of the selected instrument

• To be able to adjust the configuration of the instrument it is required to authenticate oneself to the device.
The default login credentials are: Username: admin, password: 123456. Then press login
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• Go to Configuration → Communication Parameters.

Figure 25: Communication parameters

• Tick the flag Contact Remote Servers to configure a connection to a remote server.

• Go to Server Parameters

Figure 26: Edit Communication parameters
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• Configure the Server IP address and press. The default Server port is 3456 and should be kept.

• Then press Save and Restart.

Figure 27: Edit Server parameters

• Under Protocol, select Custom and add the default Port : 3456.

• Then press Apply and Restart.

• After the instrument has restarted it is ready for operation and can be configured according to chapters 8
and 9.
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6 Principle of Operation of the Instrument

This chapter gives an overview of the normal operation of the instrument in a network or as a standalone unit.

6.1 Normal Operation

During normal operation the instruments are installed on sites and connected to a data server over Ethernet
or Internet. The instrument checks in a defined interval whether there are any requests or firmware updates
ready for pick up on the server. Additionally - and if configured - the instrument uploads the ringbuffer files
(from continuous recording) and the state of health files to the data server.

Figure 28: Normal operation in a network
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6.2 Behaviour on a Seismic Event

In the event of an earthquake with vibrations above the trigger threshold, the instrument will record the event
and immediately upload it to the data server (see Figure 29). In case some of the stations are too far away
from the epicentre to trigger, the data can still be collected from all instruments:

• A data request will be placed on the server

• All instruments will download the request during the next time checking the server (see Figure 30)

Figure 29: Upload of seismic events and download of requests from the server

• All instruments will create an event at the time listed inside the data request and extract these data out of
the ringbuffer data.
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• The extracted event file will be uploaded to the data server (see Figure 30)

Figure 30: Behaviour on Events: Upload of extracted events
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6.3 Firmware and Configuration Upgrade

In case of a firmware upgrade, the new firmwares can be easily put on the server. All instruments will recognise
the new firmware during the next server checkup, download and install it. See chapter 11 for details about the
firmware upgrade. The same happens also with new configurations. In case the option "Keep connection to
the server" is enabled under Server Parameters (see chapter 9.8 for details), then the instrument will keep the
channel open so that it is possible to configure the instrument via the Web Interface without knowing the IP
address of the instrument. See chapter 8 for details.

Figure 31: Firmware upgrade

6.4 Backup Server

It might be that the instrument is not able to contact the main data server anymore: either because it is down
or a wrong server has been configured. For example, this can happen if a configuration file with wrong server
settings is uploaded accidentally to an instrument. In this case the instrument will contact the backup server
that has been configured in the test and configuration menu. Therefore the configuration of the backup server
is very important and should not be ignored. For more information how to set the backup server see chapter
5.2.

Figure 32: Connection to backup server in case connection to main server fails
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7 Network Settings

The network configuration is the same whether using a wired network or wireless network. The specific settings
related to the wireless network configuration via the local console are described in chapter 7.4.

7.1 Network Settings through the Web Interface

• To open the Web Interface please do one of the following two steps:

▪ In the window Stations: General Information of GeoDAS make a right click on the station name
and click on Instrument Setup. . . or

▪ Open your browser and enter the IP address of the instrument (see chapter 7.5 for details) in the
address bar of your browser.

• To be able to adjust the configuration of the instrument it is required to authenticate oneself to the device.
The default login credentials are: Username: admin, password: 123456

• Go to the tab Configuration → Network Configuration. The following screen can be seen (pictured
below).

• Adjust the wired Ethernet settings under eth0. In case the instrument has a second wireless Wi-Fi
interface, then additionally available Wi-Fi networks can be scanned or all parameters can be manually
adjusted.

• Click Save Network Configuration to Device.
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Figure 33: Configuration of network interface
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7.2 Network Settings through GeoDAS

• Under Settings click on Configure Stations. . . , the following window appears:

Figure 34: Configuring Stations screen

• Make a right click on the station name and choose Edit Network Settings of Instrument

Figure 35: Edit Network settings

• Adjust all the network parameters in the following screen wherein the Primary Network interface is the
wired Ethernet, and Embedded Wi-Fi interface is the wireless network interface.

Figure 36: Configuration of wired Ethernet
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Figure 37: Configuration of wired Ethernet

7.3 Wired Ethernet settings through the local Console

Please see chapter 5.2 for details.

7.4 Wireless Settings through the local Console

• Switch on the instrument by pressing and holding the POWER button for 2 seconds.

• Press ‘Ctr + Z’ as soon the following message appears on the console to enter the test mode.

#################################################
###### Test and Initial Configuration Mode ######
#################################################
Press Ctrl+Z to enter the test mode.....

The following menu will appear (see chapter 10 for details):

---------------------------------------------------------------------------------------
Level Shortcut Password Description
---------------------------------------------------------------------------------------
User Ctrl+U None Basic operations only
Powerful User Ctrl+W None Also hardware options and pre-selected tests
Administrator Ctrl+A None Also manual tests and altering the FLASH memory content
---------------------------------------------------------------------------------------
Your level [U/W/A] or press B to boot now:

• By default, no passwords are set, so press ‘U’ to enter the User Mode, and then ‘N’ to enter the menu
Network settings and proceed until the following menu appears:

---- Wireless network interface ----
Static IP address (1=YES, 0=AUTO)?

• Select if the instrument should have a static or a dynamic IP address by pressing ‘1’ (Static) or ‘0’
(Dynamic). If a dynamic IP address is chosen, a DHCP server must be available in the network to
provide the IP address settings.

• If a static IP address is selected, an additional message will appear asking for the Instrument IP address,
Instrument network mask and Instrument gateway IP address. If you don’t know these parameters please
ask your network administrator.

• By pressing ‘E’ the instrument scans the available networks and lists them. Choose the network to
connect by pressing the number next to the network SSID or press ‘C’ to configure the network settings
manually.



48 / 150
GMSplus User Manual

2023-10-02 / V25

Scanning wireless networks.
----------------------------------------------------------------------------

N Network SSID Mode Encryption Channel Level,%
----------------------------------------------------------------------------

1 GSO_ENG Infrastructure WPA2 1 81
----------------------------------------------------------------------------
Enter the number of a network above, <S>can again or <C>onfigure manually:

• If the network is encrypted, please enter the network key.

Passphrase (8-63 ASCII) or a 64-character hex key (ad43Fd2d22):

• Adjust the other parameters concerning the SSH or recovery server if required.

• When the instrument tries to connect to the network, this can take a while. Please be patient until the
following menu appears again:

Access level: User

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
N - Network settings

--- Security ---
O - Set password

-->

• Press ‘5’ to continue the boot process of the instrument.
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7.5 Get IP address from Instrument

• To get the IP address from the instrument please press ’S’ in the main user menu

Main menu:
C - Configuration
M - Messages ->
S - Shell command
L - List firmware images
X - Display errors (0) and warnings (0)
W - Clear errors and warnings
F - View/reset RTC trim values
T - File statistics
G - View RTC status
P - View GPS information
H - Set RTC time
U - User request
R - Restart
Q - Quit

• Enter the Linux command ifconfig and the following reply will be shown by the instrument

• Please see the IP addresses of the wired Ethernet (eth0) and the wireless Ethernet (wlan0) listed and
marked here in red.

Linux Command: ifconfig
eth0 Link encap:Ethernet HWaddr 00:50:C2:77:42:8E

inet addr:192.168.10.133 Bcast:192.168.10.255 Mask:255.255.255.0
inet6 addr: fe80::250:c2ff:fe77:428e/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:71 errors:0 dropped:1 overruns:0 frame:0
TX packets:16 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:6538 (6.3 KiB) TX bytes:1678 (1.6 KiB)
Interrupt:21 Base address:0x4000

lo Link encap:Local Loopback
inet addr:127.0.0.1 Mask:255.0.0.0
inet6 addr: ::1/128 Scope:Host
UP LOOPBACK RUNNING MTU:16436 Metric:1
RX packets:3 errors:0 dropped:0 overruns:0 frame:0
TX packets:3 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:0
RX bytes:172 (172.0 B) TX bytes:172 (172.0 B)

wlan0 Link encap:Ethernet HWaddr 00:0D:F0:8E:05:DF
inet addr:192.168.10.94 Bcast:192.168.10.255 Mask:255.255.255.0
inet6 addr: fe80::20d:f0ff:fe8e:5df/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1
RX packets:2333 errors:0 dropped:95 overruns:0 frame:0
TX packets:636 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:271699 (265.3 KiB) TX bytes:737148 (719.8 KiB)
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8 The Web Interface

The instrument can be configured over a Web Interface. To be able to use the Web Interface, it is necessary
that the following criteria are fulfilled:

• The IP address of the device has to be known or the flag Keep connection to the server under Server
Parameters (see chapter 9.8 for details) must be enabled (set to Yes).

• In case the flag Keep connection to the server is disabled, the port 80 of the device has to be accessible,
from the accessing computer. This usually means that the instrument is in the same network as the
accessing computer and no firewall mechanism separates the two.

• A current browser version has to be available on the accessing computer.

8.1 Accessing the Web Interface

• To access the instrument please follow one of the following two steps.

▪ In the window Stations: General Information of GeoDAS make a right click on the station name and
click on Instrument Setup. . . , as can be seen previously in Figure 23, or

▪ Open your browser and enter the IP-Address (e.g. 192.168.30.176) of the device in the address bar
of your browser.

Figure 38: The login screen of the instrument at 192.168.30.176

To be able to adjust the configuration of the instrument or access its data, it is required to authenticate oneself
to the device. This can be done by entering a valid username and corresponding password in the fields of the
same name and pressing the "login" button.

The default login credentials are:

• Username: admin
• Password: 123456

The default password can be changed as described in the chapter 8.3.4 of this manual. If the admin password
is forgotten, please delete the webuser.txt file on the SD card of the instrument to restore the default password.

The Web Interface can be disabled under Network settings in the Administrator mode of the test
and configuration menu. See chapter 10 for details.
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8.2 The Home Panel and the General Navigation

After the login process has ended, the screen shown in Figure 39 becomes visible. The width of the Web
Interface is optimised for a screen width of 1024 pixels. If the width of the browser window is smaller than that,
it might be necessary to scroll horizontally.

Figure 39: The home panel of the web interface

As can be seen in Figure 39, each screen in the web interface is separated into three sections:

1. The Navigation Bar: The navigation bar allows accessing all screens within the web interface. The
navigation bar is further separated into two parts. The top bar is the primary navigation panel which is
visible from all screens. The currently active tab is marked white, while all other – inactive – tabs are blue.
By changing from one tab to another, the secondary navigation panel becomes active. This secondary
navigation tab allows to switch between the actual screens within a primary navigation bar.

2. The Content Section: This section will contain all information and configuration options. Most interaction
will take place in this part.

3. The Device State Summary: On the left side the Station Description and Serial Number is displayed to
identify the current instrument you are working on. On the right side the device state summary describes
the overall status of the instrument. The states that are possible are listed in Table 7. By clicking on the
overall state, information on the actual problems will be displayed. More detailed information on the error
states are provided in the menu item "State of Health" as described in chapter 8.4.

Symbol Meaning Description

No errors or warnings re-
ported from the device.

As there seem to be no issues, no action is required.

A warning is reported
from the device

There seems to be an issue in this module. Al-
though it seems not to be critical, it is recommended
to check why this warning is displayed and take ac-
tions to resolve it.

An error is reported from
the device

An error has occurred and it is required to check for
the cause of the problem and resolve it in order to
avoid limited functionality.

Table 7: The overall error states shown in the Web Interface
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8.3 Device Configuration

The configuration screen of the Web Interface gives access to all configuration options, the configuration
management of the Data Acquisition Software as well as the Network Configuration and the Web Interface
itself.

Loading the configuration can take a few seconds. During this time at the right corner of
the browser Loading. . . is displayed. Please be patient till the screen shown in Figure 40
appears.

Figure 40: Configuration main menu
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8.3.1 Data Acquisition Configuration

The Data Acquisition sub menu provides access to the data of the current configuration of the data acquisition
software. As depicted in Figure 41, the content of this tab is divided into two sections:

1. The Configuration Value Panel: This is main part of the armdas Configuration screen. Within this part
of the screen all the values of the configuration of the selected Configuration Menu Item can be adjusted.
Most options will provide a help button in the form of white question mark on blue ground on the right part
of this section. By clicking on it information will be displayed over the option. Please note that the only
way to restore the original values of the fields after making changes to them is by using the "Load from
Device" Button in the Action Panel.

2. The Action Panel: This panel is providing the option to either reload the current configuration from the
device (to discard changes or load changes done by another user) or to save the edited configuration
to the device or to save the edited configuration to the device and restart the data acquisition software.
Saving and restarting will interrupt the current recording for about 20 seconds. During this time triggers
will not be executed either. Please note that if the device is configured to use a DHCP server, the address
might change during the saving of the configuration which will make the web interface inaccessible under
the old address.

Figure 41: Configuration panels
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8.3.2 Configuration Manager

As described in the previous chapter, the Data Acquition screen only allows configuring the currently used
configuration. The Configuration Manager screen described in this chapter allows managing several config-
urations, changing the current configuration, uploading a new configuration and so on. As depicted in Figure
42, the screen is divided into three sections:

1. The Configuration List: This list contains all configurations currently available on the SD or CF card.
The Current Configuration should always be listed in this list. This configuration can be copied and
downloaded but not renamed, removed or made the current configuration (as it is already the current).
As depicted in Figure 43, these options become available to other configurations stored on the SD card
(in this example after uploading a file to the device). When pressing Use as Current Configuration it will
store this configuration as the Current Configuration. The existing configuration will be overwritten and
the instrument restarted. Note that only the Current Configuration can be edited in the Firmware screen.
The other configuration files will remain untouched. The Current Configuration can be saved in a file by
pressing Copy.

2. The Upload Panel: While the Configuration List allows downloading configurations from the device by
clicking on the name, this part of the screen provides the possibility to upload a configuration to the web
interface by selecting a configuration on the PC and using the Upload Button. As can be seen in Figure
43, after a successful upload a new file is shown in the Configuration List and the name of the newly
available configuration is written at the top of the list. (The name of new configuration will be created
from a random string followed by "_config.xml"). The configuration can then be changed by clicking on
Rename. Note that the upload panel might look different depending on the browser in use.

3. User Default Panel: With the Reset To the User Default Config, the Current Configuration will be
overwritten by the user default (see command SETDEFCFG in the chapter 9.12.1) and the instrument
will be restarted. The Current Configuration can be saved as the user default by pressing the button
Make current Config the User Default Config

Figure 42: Configuration Manager screen

Figure 43: New file upload
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8.3.3 Network Configuration

8.3.3.1 Wired Ethernet

The Network Configuration screen provides the possibility to change the network configuration of all network
interfaces of the instrument. For the standard instrument only one network interface is available: the Ethernet
interface, which is present in all devices. (This interface is marked as "LAN" in Figure 4). This interface can be
configured in the section of the screen that is marked with the red number "1" in Figure 44. The top part of that
framed, red section describes the current configuration of the interface. The part below allows changing this
configuration. The name of this network interface is traditionally eth0.

8.3.3.2 Wi-Fi Wireless Ethernet

Some devices contain an additional wireless interface (marked as "Wi-Fi" in Figure 4). If this is the case, a
second configuration panel is shown in the Network Configuration screen as can be seen Figure 44 (marked
with the red number "2"). As with the default Ethernet interface the section surrounded by the red frame is
split in two parts, where the top part defines the current settings and the bottom part provides the possibility
to change the configuration. Additionally to the standard network settings like IP Address, Netmask, Gateway
and so on, the actual wireless settings can be adjusted and open wireless networks scanned. The name of
this network interface is traditionally wlan0.

Figure 44: Network Configuration Screen
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8.3.4 Web Interface Configuration

The Web Interface Configuration screen allows configuring all settings related to the Web Interface. At the
moment, this solely consists of the possibility of changing the password for the login. To change the password
press Change Password. The current password has to be known.

The default login credentials are:

• Username: admin
• Password: 123456

If the admin password is forgotten, please delete the webuser.txt file on the SD or CF card and restart the
instrument to restore the default password.

Figure 45: Web Interface Configuration Screen
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8.4 State of Health

The State of Health (SOH) menu item provides all information related to the error status of the device as well
as the status of the available hardware and software versions.

8.4.1 Error Status

As depicted in Figure 46, this screen provides basic information on the device at hand (area 2) as well as the
error status for each module (area 3). The summary of this SOH information is visible at the bottom of each
page as the Device State Summary, described in chapter 8.2. Additionally it is possible to download the State
of Health information as a file in XML format – this is possible in all sub-menu items of the State of Health
menu – and clear the errors (area 1).

Figure 46: Error Status Screen

The modules in area 3 can have one of the states defined in Table 7.
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8.4.2 Recording Status

This screen provides all information on the recording and time synchronisation status of the device. As depicted
in Figure 47, this screen contains information on the number of events, the timing and synchronisation status
of the device, as well as information about the GPS quality and the GPS position of the instrument.

Figure 47: Recording Status Screen



GMSplus User Manual
2023-10-02 / V25 59 / 150

8.4.3 Hardware Status

The Hardware Status provides such information as uptime, available disk space, the device temperature
and so on. Information about the available hardware options in the instrument, such as Alarm Boards, Wi-Fi
Modules and Modems can be found in the section Hardware Configuration Status.

Figure 48: Hardware Status Screen
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8.4.4 Software Status

The Software Status screen contains information on the Software Versions.

Figure 49: Software Status Screen

The section Software Upgrade allows to download firmware directly through the Web Interface.

• Click on Choose File, select a firmware to upgrade and click on Upload Software.
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8.4.5 Maintenance

As shown in Figure 50, the Maintenance screen enables manage the data file, start a trigger, get SOH file and
sending signal-related requests to the data acquisition software.

Figure 50: The Maintenance Screen

The Data Management allows to manage the files and start a trigger

• File deletion allows to user to delete all or a specific type of file.

• Trigger by request and create a data file can start a trigger by click on Trigger Now.

The Status and information allows to update or download the SOH file.

• Request actual status of the system in a file allows to user to delete all or a specific type of file. It
sends a request instrument to execute seflcheck and update its state of health. It may take a while to
complete, and then you can download updated information in a SOH file.

The Miscellaneous Requests allows to do different tasks:

• Synchronise instrument time with PC time: If your instrument does not have a GPS and does not
connect to NTP servers, you can set its time from your browser. The method is not very precise.

• Send a Test Pulse: By sending this request, a test pulse will be executed. The sensor should then
respond accordingly and thus provide information about its status.

• Remove DC from Signal: By sending this request, a baseline correction will be applied to the signal and
therefore remove the DC from the value, caused by e.g. a slight misalignment of the sensor.

• Battery maintenance command: if your instruemnt has internal battery, you must update this informa-
tion every time when you replace it.

• Send any command: Type any known command supported by firmware and press Send.
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If the Seismometer Control option is available, it is possible to control the mass from this window as well as
can be seen in Figure 51. The following commands are supported:

• Lock: Locks the seismometer.

• Unlock: Unlocks the seismometer. After unlocking, the sensor automatically centres its mass.

• Center: Centring of the mass

During all controls, the field Current Mass Position shows current pass positions of the channels East-West,
North-South and Vertical in mV. Feedback about the progress and status information can be found under
Seismometer Control Output.

Figure 51: Seismometer Control
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8.5 Data Explorer

The Data Explorer provides the possibility to gather information on the files stored on the SD or CF card. The
file types are separated into three different file types:

• Automatically Detected Events (Event- and Calibration files)

• Manually Triggered Events and Request Data (Event- and Calibration files)

• Status and Information (SOH- and Log-files)

• Ringbuffers (Ringbuffer files)

With the menu at the top of the Data Explorer it is possible to switch between the file types listed above.
For each listed file, the information on its file size and the last modification time are displayed. The files can
be sorted according to the file name, size or modification date. By clicking on the file name, the file can be
downloaded.

Figure 52: The Data Explorer Screen
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8.6 Help

The Help Menu provides help if there are any problems with the device or the Web Interface.

8.6.1 Online Help

On this screen, the current version of the GMSplusUser Manual can be downloaded from the device. This
manual contains additional information on the instrument, which is not provided in the interface itself.

Figure 53: Download the GMSplusUser Manual

8.6.2 Contact GeoSIG Service

This screen provides information on how to contact GeoSIG service in the case of problems. The links provided
on this screen will only work if access to the Internet is available.

Figure 54: Contact information
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9 Detailed Configuration of the Instrument

9.1 Switch ON and OFF the Instrument

The main power switch operates as follows:

• Open the housing lid of the instrument by removing the four screws in the corners.

• Press the POWER button for 2 seconds to switch the instrument ON.

• The SYSTEM indicator changes to solid white indicating that Linux OS is starting up and then it is flashing
white indicating that the data acquisition software is starting up. If POWER indicator is flashing red
instead, the instrument is not turning on because of low battery voltage. If SYSTEM indicator is flashing
red instead, the instrument is not turning on because of high temperature (See Table 1 for details). It is
possible to force the instrument to turn on neglecting the battery voltage and the temperature by pressing
the POWER button for 10 seconds.

• To turn the instrument OFF, press the power button for a minimum of 2 seconds and wait for the operating
system to shutdown properly. It is possible to force an immediate power off by pressing the POWER
button for 10 seconds.

9.2 General Comments to the Configuration

All the configuration changes can be done either over the network by the Web Interface and GeoDAS or on the
instrument itself using a standard Micro USB patch cable on the internal Micro USB connector and a terminal
program.

9.2.1 Change Configuration by the Web Interface

• Open an Internet browser and enter the IP address of the device in the address bar of your browser.

• Login with the username: admin and the password: 123456

See chapter 8 for the full explanation of the Web Interface.

9.2.2 Change Configuration by GeoDAS

• In the window Stations: General Information make a right click on the station name.

Figure 55: Instrument setup

• GeoDAS is opening the default Internet browser. The Web Interface of the instrument will appear. See
chapter 8 for the full explanation of the Web Interface.
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9.2.3 Changing Configuration by the Console

• Connect the GMSplus to a serial port of your computer and switch on the instrument if not already done.

• In GeoDAS go to Tools → Terminal. . . and choose your COM Port. As Baud rate select 115200. Then
Press Connect. Any terminal application of your choice can be used alternatively.

• Press <Enter> the following menu appears:

Main menu:
C - Configuration
M - Messages ->
S - Shell command
L - List firmware images
X - Display errors (0) and warnings (0)
W - Clear errors and warnings
F - View/reset RTC trim values
T - File statistics
G - View RTC status
P - View GPS information
H - Set RTC time
U - User request
R - Restart
Q - Quit

• To configure armdas, from GMSplus console, press ‘C’ and <Enter>. If you are asked, select Edit current
configuration, by pressing ‘C’ again.

• Change the configuration as described in the following chapters, always type first the desired function
and confirm with <Enter>.

• Press <Esc> to leave the configuration menu. If asked, select save as current configuration, by press-
ing ‘C’
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9.2.4 Explanation of the Structure in the Manual

As the parameters in the configuration sometimes depend on each other, not all parameters are shown all the
time. The configuration is also sorted in several sub-menus. Therefore the menu is explained as following:

Parameter in the menu Possible selections
or ’User selectable’

Explanation

Switch-Parameter Possible selections
or ’User selectable’

Explanation: The following three
lines depend on the selection and
are only visible if not set to ’No’

This Parameter is only visible
if Switch-Parameter has been
set to Yes

Possible selections
or ’User selectable’

Explanation

This Parameter is only visible
if Switch-Parameter has been
set to Yes

Possible selections
or ’User selectable’

Explanation

Parameter in the
Submenu

Possible selections
or ’User selectable’

Explanation
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Parameter in the
Submenu

Possible selections
or ’User selectable’

Explanation

Parameter in the Submenu Possible selections
or ’User selectable’

Explanation

Parameter in the Submenu Possible selections
or ’User selectable’

Explanation

Switch-Parameter in the Submenu Possible selections
or ’User selectable’

Explanation

S
ub

m
en

u

This Parameter is only visible
if Switch-Parameter has been
set to Yes

Possible selections
or ’User selectable’

Explanation

Table 8: Explanation table structure
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9.3 Configuration of the Channels

9.3.1 In the Web Interface or by GeoDAS

• In the field Configuration → Number of Channels the total number of channels must be configured
first.

Figure 56: Configure Number of Channels
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• Go to Configuration → Channel Parameters to edit the channel parameters. See Table 9 for additional
information.

Figure 57: Edit Channel Parameters
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9.3.2 Via Local Serial Console

• Press ‘E’ to select the number of channels. By default three channels are configured as most sensors
have three channels normally.

Configuration
A) Station description ............. GeoSIG Station
B) Station code .................... GSGMS
C) Location description ............ Default location
D) Seismic network code ............ GS
E) Number of Channels .............. 3
F) Number of Output Streams ........ 0
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘I’ to get to the Channel Parameters menu to adjust the settings of the channels. The following
menu appears:

Configuration | Channel 1 of 3
A) Data source ..................... INT-ADC-S01-C01
E) Channel name .................... C01
F) Location code ................... LC
G) Source data unit ................ g
H) LSB factor ...................... 2.50986e-07
I) Sampling rate, sps .............. 1000 (0x3E8)
K) Negative axis ................... No
L) Offset compensation ............. Yes
N) Maintain the ringbuffer ......... Yes
O) Online preprocessing ............ None
S) Decimation and peaks ............ None

• Each channel can be adjusted according to your wishes. To change the channels press ‘+’ or ‘-’. The
following parameters can be adjusted:
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‘+’ and ‘-’ can be used to change between the channels
Data source The source of the channel can be defined

INT-ADC-Sxx-Cxx See chapter 9.3.4
EXT-ADC-Sxx-Cxx
DATACHAN Virtual channels
DATAVSUM Vector sum of two channels
DATAVSU3 Vector sum of three channels

Source channel name User selectable The source of the virtual channel can be any other
channel

Second source channel User selectable In case of the vector sum a second or third source
has to be selected

Third source channel User selectable
Channel name User selectable The channel name in the record is a combination

of the location code and channel name
Location code User selectable
Source data unit User selectable Data unit of the selected channel
LSB factor User selectable LSB factor, depending on the connected sensor.

See chapter 9.3.3 for details and Table 10 for the
specific values of the sensors.

Sampling rate, sps 50, 100, 200, 250,
500, 1000*

Sampling rate of the selected channel
* 1000 SPS only valid with 3 channels or less.

Negative axis Yes Inversion of the axis is enabled
No Inversion of the axis is disabled

Offset compensation No Compensation is disabled, fill out offset value
Yes Compensation is enabled

Fixed offset value (units) User selectable If No is selected, this value will be deducted at
all time from the recorded sensor signal. This is
helpful if the sensor produces a fixed, static offset
which is present all the time.

Maintain ringbuffer Yes Permanent recording is enabled
No Permanent recording is disabled

Online processing None No online processing
Filtering Use an online filtering with filter parameters
Integration Use an online integration with filter parameters
Double-integration Use an online double-integration with both filters

parameters
Pre-filtering Use an online pre-filtering with filter parameters

Filter type Highpass A Highpass will attenuate all frequencies below a
defined frequency.

Lowpass A Lowpass will attenuate all frequencies above a
defined frequency.

Bandpass A Bandpass will attenuate all frequencies below a
defined frequency and above a defined frequency.

Fi
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m
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s

Filter order User selectable Defines how much the attenuation increases per
decade below the Low Frequency Corner respec-
tively above the High Frequency Corner. The at-
tenuation increases by the filter order multiplied
with 20 dB. User can choose between these val-
ues: [2-4-6-8-10-12]
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Flow, Hz User selectable The Low Frequency Corner of the filter is the point
where the attenuation is 3 dB. Below this fre-
quency, attenuation will increase depending on the
Filter Type
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Fhigh, Hz User selectable The High Frequency Corner of the filter is the
point where the attenuation is 3 dB. Above this fre-
quency, attenuation will increase depending on the
Filter Type

Filter type Highpass A Highpass will attenuate all frequencies below a
defined frequency.

Lowpass A Lowpass will attenuate all frequencies above a
defined frequency.

Bandpass A Bandpass will attenuate all frequencies below a
defined frequency and above a defined frequency.

Filter order User selectable Defines how much the attenuation increases per
decade below the Low Frequency Corner respec-
tively above the High Frequency Corner. The at-
tenuation increases by the filter order multiplied
with 20 dB. User can between this value: 2-4-6-
8-10-12

Flow, Hz User selectable The Low Frequency Corner of the filter is the point
where the attenuation is 3 dB. Below this fre-
quency, attenuation will increase depending on the
Filter Type
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Fhigh, Hz User selectable The High Frequency Corner of the filter is the
point where the attenuation is 3 dB. Above this fre-
quency, attenuation will increase depending on the
Filter Type

Post-integration filtering Yes The post-integration is enabled
No The post-integration is disabled

Processing data unit User selectable This will often be identical to the ’Unit of the data’,
but may differ if e.g. an integration is performed.

Decimation and peaks None No decimation
Decimation Additional down sampling of the data
Peak Values Peak values of the data within a certain interval
Average Values Average values of the data within a certain interval

Decimation factor User selectable The signal will be decimated by the selected factor.
E.g. if the sample rate is 50 and the decimation
factor 10, then the output sample rate is 5 SPS. Be
aware that no anti-aliasing filtering is done prior to
decimation!

Interval of calculation, sec User selectable The Peak or Average values of the signal within
the time defined in the Interval of averaging will be
written into the ringbuffer with the specified Output
sampling interval in [seconds]. Interval of averag-
ing should be equal or higher than the Output sam-
pling interval.

Output sampling User selectable The Peak or Average values of the signal within
the time defined in the Interval of averaging will be
written into the ringbuffer with the specified Output
sampling interval in [seconds]. Interval of averag-
ing should be equal or higher than the Output sam-
pling interval.

Table 9: Channel configuration menu structure
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9.3.3 Calculation of the LSB factor

This section defines the calculation of the LSB value for the GMSplus that has to be configured in the Channel
Parameters.

In the Web Interface, the conversion from LSB to Full Scale and backwards is done automatically. In case the
instrument is configured over GeoDAS or the console, the LSB value must be entered.

9.3.3.1 Overview

The LSB values of all GeoSIG sensors for the GMSplus can be found in the following table

Sensor type Full Scale Output Voltage Range LSB

AC-xx +/-0.5 g +/- 10 V 0.662’274e-7 g/count

+/- 1 g +/- 10 V 1.324’548e-7 g/count

+/- 2 g +/- 10 V 2.649’095e-7 g/count

+/- 3 g +/- 10 V 3.973’643e-7 g/count

+/- 4 g +/- 10 V 5.298’191e-7 g/count

VE-13 1 mm/s +/- 10 V 1.324’548e-7 mm/s/count

VE-23 10 mm/s +/- 10 V 1.324’548e-6 mm/s/count

100 mm/s +/- 10 V 1.324’548e-5 mm/s/count

VE-33 Sensitivity: 27.3 V/m/s (27.3 V/m/s) 4.851’822e-8 m/s/count

4.851’822e-5 mm/s/count

VE-53 Sensitivity: 1000 V/m/s (2x 500 V/m/s) 1.324’548e-9 m/s/count

1.324’548e-6 mm/s/count

Sensitivity: 200 V/m/s (2x 100 V/m/s) 6.622’738e-9 m/s/count

6.622’738e-6 mm/s/count

Table 10: LSB of all GeoSIG sensors

If you have a different kind of sensor, the LSB can be calculated according to the following chapters.
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9.3.3.2 Calculate LSB from Sensors with given Full Scale

Output Voltage of the sensor and input range of the recorder is +/- 10 V (GeoSIG Standard)

LSB =
FullScale

0.9 ⋅ 223
=

FullScale

7 549 747.2

Example, 3 g sensor

LSB =
3 g

0.9 ⋅ 223 counts
=

3 g
7 549 747.2 counts

= 3.973 643e−7 g/count

Output Voltage of the sensor and input range of the recorder is not +/- 10 V

LSB =
FullScale

0.9 ⋅ 223
⋅
RecorderFullScale(V )
SensorFullScale(V )

Example, 3 g sensor

LSB =
3 g

0.9 ⋅ 223 counts
⋅
10V

2.5V
= 1.589 457e−6 g/count

9.3.3.3 Calculate LSB from Sensors with given Sensitivity

Input range of the recorder is +/- 10 V (GeoSIG Standard)

LSB =

RecorderFullScale(V )
Sensitivity

0.9 ⋅ 223 counts
=

10V
Sensitivity

0.9 ⋅ 223 counts
=

1.324 547e−6 V
count

Sensitivity

Example, 1000 V/m/s sensor

LSB =

10V

1000 V
m/s

0.9 ⋅ 223
=

1.324 547e−6 V
count

1000 V
m/s

= 1.324 547e−9
m
s /count
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9.3.4 Channel Naming

The naming of the channels is organised as following: all internal sensors start with INT-ADC, all external
sensors with EXT-ADC.

xxx-ADC-Syy-Czz

xxx Source INT Internal Sensor

EXT External Sensor

yy Sensor 3ch: S01

6ch: S01,S02

zz Channel C01 . . . C03

For example if there are two external sensors connected, the following channels are available:

EXT-ADC-S01-C01 EXT-ADC-S02-C01

EXT-ADC-S01-C02 EXT-ADC-S02-C02

EXT-ADC-S02-C03 EXT-ADC-S02-C03
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9.4 Configuration of Data Streams

9.4.1 In the Web Interface or by GeoDAS

• In the field Configuration → Number of Output Streams the total number of output streams must be
configured first so that the Stream Parameters menu appears.

Figure 58: Configure number of Output Streams

• Go to Configuration → Stream Parameters to edit the stream parameters. See Table 11 for additional
information.

Figure 59: Edit Stream Parameters
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9.4.2 Via Local Serial Console

• Press ‘F’ to select the Number of Output Streams. One output stream can have several channels.

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘J’ to get to the Stream Parameters menu to adjust the settings of the output streams. The following
menu appears:

Main Menu | Stream
A) Stream name ................. Stream_1
B) Stream type ................. GSBU
C) Port configuration .......... ->
D) Channels in the stream ...... 3
E) List of streamed channels ... ->
F) Data frames per packet ...... 5 (0x05)
G) CRC32 protected packets ..... No
H) Number of padding bytes ..... 0 (0x00)

• Each output stream can be adjusted according to your wishes. To change the output stream press ‘+’ or
‘-’. The following parameters can be adjusted:
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‘+’ and ‘-’ can be used to change between the channels
Stream name User selectable Name of the output stream
Stream type GSBU Streaming possibly in GSBU format only

Communication Port TCP/IP Streaming over the network
Protocol TCP(SERVER) GeoDAS software or any other client supporting the

selected protocol connects to the IP address config-
ured under ‘IP Address’ for data streaming

Network Port User selectable Server port listening for incoming connections

Baud Rate 1200 Baud rate of the serial data stream. Make sure that
the serial port of the computer is configured to the
same baud rate.

2400
4800
9600
19200
38400
57600

Po
rt

co
nfi

gu
ra
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n

115200
Channels in the stream User selectable Number of channels which should be streamed

‘+’ and ‘-’ can be used to change the channels

Li
st

of
st
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ed
ch
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ls

Assigned channel name User selectable Depending on the number of channels, for every
channel a different source can be selected; the
source can be selected by pressing ‘A’.

Data frames per packet User selectable Specifies the packet length of the streams (one data
frame is equal to 200 ms). For example if ‘5’ is se-
lected, then every second a packet with the last sec-
ond of data will be sent.

CRC32 protected packets Yes Enable CRC32 protection for the stream
No Disable CRC32 protection for the stream

Number of padding bytes User selectable Add the specified number of padding bytes to the
stream

Table 11: Data streaming configuration menu structure
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9.4.3 Set up of Data Streams

This chapter will describe how to set up an instrument for data streaming.

9.4.3.1 In the Web Interface or by GeoDAS

• Connect to the Web Interface and configure the number of the Data Streams in the field Configuration
→ Number of Output Streams. One output stream can have several channels.

• Go to Configuration → Stream Parameters to adjust the settings of the output streams.

9.4.3.2 Via Local Serial Console

• Connect to the instrument and press ‘F’ to select the Number of Output Streams. One output stream can
have several channels.

• Press ‘J’ to get to the Stream Parameters menu to adjust the settings of the output streams.

• Adjust the settings according to chapter 9.4. Carefully select the settings in the Port Configuration. If you
want to stream over Ethernet, choose TCP/IP and TCP (Server).

Not more than three channels could be streamed though the same port.
Important: If multiple streams are configured, they must have different network ports
(e.g. 4002 as default port is 4001)

Main Menu | Stream | Port
A) Communication port ... TCP/IP
C) Protocol ............. TCP (Server)
E) Network port ......... 4001 (0xFA1)

• If you want to stream over the SERIAL port on the front of the instrument, choose ttyS03.

Main Menu | Stream | Port
A) Communication port ... ttyS03
B) Baud rate ............ 115200

• Open GeoDAS and go to the menu Settings → Channels of Digitizers. . . The following window ap-
pears:

• Adjust the Name, choose any three-letter code for the data stream

• Select as Type the GeoSIG Packet Digitizer

• Press Add/Modify

• Make sure the selected Sample rate is the same as in the instrument.
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Figure 60: Channels of Digitizers

• Choose either the Local COM port (if connected over RS-232) or the Remote host IP address and
port (if connected over Ethernet). The instrument’s IP address must be known.

• Check the flag Use channel parameters provided by the digitizer.

• Press OK.

• After a restart of GeoDAS, the window Stations: Data Streams appears:

Figure 61: Stations: Data Streams

• To view the data make a right click on the station name (here TST00) and select Data Monitor

Figure 62: Data stream window
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9.5 Trigger Settings

The instrument allows having several triggers with independent sources in parallel.

9.5.1 In the Web Interface or by GeoDAS

• Go to Configuration → Number of Trigger Sets and configure the number of the desired Trigger Sets.

Figure 63: Trigger settings
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• To edit a trigger go to Configuration → Trigger Parameters. See Table 12 for additional information.

Figure 64: Edit Trigger Parameters
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9.5.2 Via Local Serial Console

• Press ‘G’ to select the Number of Trigger Sets

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘K’ to get to the Trigger Parameters menu to adjust the settings of the triggers. The following menu
appears. In case the number of trigger sets is set to ‘0’ this menu can not be selected.

Main Menu | Triggerset
A) Triggerset name ............................ Trigger1
B) Trigger source ............................. Local triggers
D) Trigger time frame, sec .................... 3 (0x03)
E) Count trigger votes by ..................... Channels
F) Minimum number of votes .................... 1 (0x01)
G) Monitored channels ......................... 9
H) Trigger channel settings ................... ->
J) Event recording ............................ No
R) Alarm activation ........................... No
V) SMS Alarm .................................. No
X) Contribute to network triggers ............. No

• Each trigger set can be adjusted according to your wishes. To change the trigger set press ‘+’ or ‘-’. The
following parameters can be adjusted:
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‘+’ and ‘-’ can be used to change between the channels
Triggerset name User selectable Name of the trigger set
Trigger time frame, sec User selectable See chapter 9.5.5 for details
Trigger source Network voting

logic
Choose the trigger source

Local triggers
Support triggers through
Interconnection

Yes This recorder will broadcast a Network Trig-
ger Alert (in case the instrument is intercon-
nected over RS-485 with other instruments)
as soon as this triggerset becomes active.

No No trigger through interconnection
Serial numbers of networked
instruments

User selectable Whitespace or comma separated list of in-
struments which contribute to the Network
voting logic.

Contribute to network triggers User selectable If this option is active, this recorder will
broadcast a Network Trigger Alert

Monitored channels User selectable Number of channels which will be moni-
tored by the selected trigger set

Count trigger votes by Channels Choose one trigger vote in this list
Channel weight
Sensor
Station

Minimum number of votes User selectable Define the number of incoming network trig-
gers of the same name that have to be ob-
served in order to make this device trigger

Assigned channel name User selectable Configure the first Data Source for this
channel.

Trigger filter Yes Trigger filter is used as defined under Filter
Parameters

No Trigger filter is not used
Filter type Highpass A Highpass will attenuate all frequencies

below a defined frequency.
Lowpass A Lowpass will attenuate all frequencies

above a defined frequency.
Bandpass A Bandpass will attenuate all frequencies

below a defined frequency and above a de-
fined frequency.

Filter order User selectable Defines how much the attenuation in-
creases per decade below the Low Fre-
quency Corner respectively above the High
Frequency Corner. The attenuation in-
creases by the filter order multiplied with 20
dB. User can choose between these values:
[2-4-6-8-10-12]

Flow, Hz User selectable The Low Frequency Corner of the filter is
the point where the attenuation is 3 dB. Be-
low this frequency, attenuation will increase
depending on the Filter Type
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Fhigh, Hz User selectable The High Frequency Corner of the filter is
the point where the attenuation is 3 dB.
Above this frequency, attenuation will in-
crease depending on the Filter Type
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Level Trigger Yes Level trigger is enabled
No Level trigger is disabled

Threshold
(channel units)

User selectable As soon the data is above the configured
threshold the trigger is activated

Min. level exceedance,
sec

User selectable The threshold or STA/LTA ratio has to be ex-
ceeded at least for the configured time in
seconds to active the trigger

STA/LTA Trigger Yes STA/LTA trigger is enabled
No STA/LTA trigger is disabled

STA time frame, sec User selectable Length of STA time window, seconds
LTA time frame, sec User selectable Length of LTA time window, seconds
STA/LTA trigger ratio User selectable As soon the data is above the configured

STA/LTA ratio the trigger is activated
STA/LTA detrigger ratio User selectable As soon the data is below the configured

STA/LTA ratio again the trigger is deacti-
vated

Min. ratio exceedance,
sec User selectable The threshold or STA/LTA ratio has to be ex-

ceeded at least for the configured time in
seconds to active the trigger

Clamp LTA during event Yes As soon the data is below the configured
STA/LTA ratio again the trigger is deacti-
vated

No
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Channel trigger weight, % User selectable See chapter 9.5.4 for details
Event recording Yes An event file will be recorded on a trigger

No No event file will be recorded on a trigger
Pre-event User selectable Pre-Event time, seconds
Post-event User selectable Post-Event time, seconds
Max. event duration, sec User selectable Maximum duration of an event in seconds.

After this time, an event file will be closed
Event Processing PGM parameters An event file will be processed and a sum-

mary report will be created
No The event file will not be processed

Stored channels User selectable Number of channels, which should be
stored into an event file in case of a trigger

‘+’ and ‘-’ can be used to change the channels
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every channel a different source can be
selected; the source can be selected by
pressing ‘A’.
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Alarm activation Yes An alarm relay will be activated on a trigger
(Only visible in case alarm relay No No alarm relay will be activated on a trigger
card is installed) This option has an effect only in case the

instrument has internal alarm relays
Alarm output to activate AL1, AL2, select the alarm output you want to activate

in case of a trigger. (*) Not available in all
models

AL3*, AL4*
Alarm deactivation delay User selectable Time in seconds the alarm relay deacti-

vates again after the signal falls below the
trigger threshold. Can be compared to the
post event time for the recording

Alarm acknowledge User selectable Digital input to acknowledge and reset the
alarm. See appendix A

Send SOH upon alarm activation Yes Defines whether a SOH information will be
cre-

No ated and transferred to the server upon
alarm deactivation

SMS Alarm Yes An SMS will be sent upon a trigger
No No SMS will be sent upon a trigger

(This option is available only in case an external cellular modem is connected to the instrument.)
Number of Recipients User selectable The number of recipients of the SMS alarm

can be selected
‘+’ and ‘-’ can be used to change the channels
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Recipient User selectable Phone number of the recipient. Use num-
bers only, no ‘+’ or any other character al-
lowed. The recipient can be selected by
pressing ’A’.

Table 12: Trigger settings configuration menu structure

9.5.3 STA/LTA trigger

The STA/LTA (Short Time Average/Long Time Average) ratio trigger computes the short term and long term
averages of the input (sensor) signal. When the STA exceeds a pre-selected multiple of the LTA (STA/LTA
ratio), the instrument begins to record data. The advantage of this trigger type is that the trigger sensitivity
adapts to the seismic background signal. With an increasing noise level the trigger sensitivity decreases. The
probability of having a false trigger due to noise will be minimised if a long STA averaging time is selected.
Obviously, the STA should not be chosen longer than the shortest event of interest. In addition, the STA should
be shorter than the pre-event time. If not, the initial portion of an event may not be recorded. During the steady
state of the system, the STA and the LTA will be nearly equal. The shorter STA averaging period, the more
quickly it will change with the input.

9.5.4 Trigger Weight

To activate a trigger the total trigger weight must be equal or bigger than 100%. By default all channels have
a weight of 100%, which means if a threshold is exceeded on one channel only, then the trigger is activated.
If the trigger weight were reduced on all channels to 50%, then at least on two channels the threshold would
have to be exceeded to reach 100% (50% + 50%) and activate the trigger. See Figure 65 for details.

9.5.5 Trigger Time Frame

Depending on the settings, it can be that threshold must be exceeded on two or more channels to activate the
trigger. The time of the threshold-exceedances might be slightly different on the channels, especially if two
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sensors are connected and installed on different places. To make sure that even due to this time difference the
trigger is working a trigger time frame can be defined. See Figure 65 for details.
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Figure 65: Overview of trigger weight and trigger time frame
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9.5.6 Trigger Interconnection over LAN (example of 2 out of 3 stations logic)

If there are several instruments in the same LAN, they can be interconnected over Ethernet for common
triggering.

In each instrument has to be enabled a local trigger and a network trigger. Every instrument in the network
can be configured as trigger source or accept a trigger from another device.

These following setups should be done on all of the instruments (3 instruments in this example).

9.5.6.1 Setup Server Configuration for instruments

• Press ‘N’ to enter the menu Communication Parameters and press ‘A’ activate the Contact remote
servers

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Adjust the number of server in the parameter Number of servers.

• Press ‘G’ to go in Server Parameters

Main Menu | Communication
A) Contact remote servers .................. Yes
B) Number of servers ....................... 1
C) Time interval, sec ...................... 10 (0x0A)
D) Maximum files per session ............... 10 (0x0A)
E) Connect if there are new files .......... Yes
G) Server Parameters ....................... ->
H) Server mode for other instruments ....... No
M) SeedLink server ......................... Yes
N) Accept connections ...................... Yes
O) Try next server on any transfer error ... No
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• IP address and Port from server must be adjusted in the field Server IP Address (in this example:
192.168.30.487) and Port (use 3456 as default). Make sure the Network triggers are activated by putting
Yes

Main Menu | Communication | Server
A) Server IP Address ....................... 192.168.30.48
B) Protocol ................................ Custom
C) Port .................................... 3456 (0xD80)
H) Transfer timeout, sec ................... 20 (0x14)
I) Network triggers ........................ Yes
J) Connect through PPP link ................ No
N) Keep connected to the server ............ Yes
O) Server port for permanent links ......... 54204 (0xD3BC)
P) Always connect to this server ........... No
Q) Connect failures before network error ... 0 (0x00)

9.5.6.2 Setup Trigger parameters for instruments

• Make sure on all instruments that the Number of Trigger Sets is to 2 (more can be set but to work
minimum two trigger is necessary, one for a local triger and one for the network trigger)

• press ‘K’ to enter in the menu Trigger Parameters.

Main Menu
A) Station description ............. GMSplus - GeoSIG Ltd
B) Station code .................... GSGMS
C) Location description ............ Switzerland
D) Seismic network code ............ GS
E) Number of Channels .............. 3
F) Number of Output Streams ........ 0
G) Number of Trigger Sets .......... 2
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->
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Configure the first trigger to allow the local trigger.
In this example, the trigger votes is based on the Channel weight.

Make sure that on all the instruments that the name of triggers are exactly the same for local triggers.

• Be sure that the Triggerset name is Trigger1 and that the Trigger source is Local Triggers.

• Be sure that the Contribute to network triggers is enabled (Yes), if not press on ‘X’ to activate it.

• Press ‘H’ to enter in the Trigger channel settings.

Main Menu | Triggerset 1 of 2
A) Triggerset name ............................ Trigger1
B) Trigger source ............................. Local triggers
D) Trigger time frame, sec .................... 3 (0x03)
E) Count trigger votes by ..................... Channel weight
G) Monitored channels ......................... 3
H) Trigger channel settings ................... ->
J) Event recording ............................ Yes
K) Preevent, seconds .......................... 5 (0x05)
L) Postevent, seconds ......................... 10 (0x0A)
M) Maximum event duration, seconds ............ 60 (0x3C)
N) Stored channels ............................ 3
O) List of stored channels .................... ->
V) SMS Alarm .................................. No
X) Contribute to network triggers ............. Yes

• For each channel, be sure that the Level Trigger is activated (Yes) .

• Adjust if necessary the following parameters:

▪ Threshold (channel units)

▪ Min. level exceedance

▪ STA/LTA Trigger

▪ Channel trigger weight

Main Menu | Triggerset | Trigger Channel 1 of 3
A) Assigned channel name ........ X0HLE
B) Trigger filter ............... Yes
C) Filter parameters ............ ->
D) Level Trigger ................ Yes
E) Threshold (channel units) .... 0.005
F) Min. level exceedance, sec ... 0.01
G) STA/LTA Trigger .............. No
N) Channel trigger weight, % .... 50 (0x64)

In this example, all the trigger weight are set to 50%, that means that minimum two channels need
to go over the threshold to activate a local trigger.
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Configure the second trigger to allow the network triggering. In this example, the trigger votes is based on the
Station.

Make sure that on all the instruments that the name of triggers are exactly the same for Network
voting logic.

• Come back to Triggerset menu.

• Go to the second triggerset, press on ‘+’.

• Be sure that the Triggerset name is Trigger2 and that the Trigger source is Network voting logic.

• Choose the Count trigger votes by,
in this example Stations is selected.

• Choose the Minimum number of votes who is necessary to send a network trigger.
In this example, minimum 2 stations must be triggered to send a network trigger alarm.

• Fill out all the serial numbers of the instruments to configure under Serial numbers of networked instru-
ments.
In this example there is 3 instruments with the following serial numbers: 102406 102746 102409.

Main Menu | Triggerset 2 of 2
A) Triggerset name ............................ Trigger2
B) Trigger source ............................. Network voting logic
D) Trigger time frame, sec .................... 3 (0x03)
E) Count trigger votes by ..................... Stations
F) Minimum number of votes .................... 2 (0x02)
I) Serial numbers of networked instruments .... 102406 102746 102409
J) Event recording ............................ Yes
K) Preevent, seconds .......................... 5 (0x05)
L) Postevent, seconds ......................... 10 (0x0A)
M) Maximum event duration, seconds ............ 60 (0x3C)
N) Stored channels ............................ 3
O) List of stored channels .................... ->
V) SMS Alarm .................................. No

Don’t forget to save and restart the instruments.
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9.6 Preset Trigger Settings

The instrument allows having several predefined triggers, e.g. time triggers in parallel.

9.6.1 In the Web Interface or by GeoDAS

• In the field Configuration → Number of Preset Triggers the total number of the preset triggers must be
configured first so that the Parameters of Preset Triggers menu appears.

Figure 66: Configure number of Preset Triggers

• Go to Configuration → Parameters of Preset Triggers to adjust the parameters of the preset triggers.
See Table 13 for additional information.
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Figure 67: Edit Preset Triggers

9.6.2 Via Local Serial Console

• Press ‘H’ to select the Number of Preset Triggers

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘L’ to get to the Parameters of Preset Triggers menu to adjust the settings of the preset triggers.
The following menu appears only if the number of preset triggers is higher than ‘0’.

Main Menu | TimeTableTrigger
A) Preset trigger name .......... Trigger1
B) First trigger type ........... After Startup
H) Duration, seconds ............ 30 (0x1E)
I) Total number of triggers ..... 1 (0x01)
O) Stored channels .............. 1
P) List of stored channels ...... ->

• Each trigger set can be adjusted according to your wishes. To change the preset trigger set press ‘+’ or
‘-’. The following parameters can be adjusted:
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‘+’ and ‘-’ can be used to change the preset triggers
Preset trigger name User selectable Name of the preset trigger set
First trigger type Manual Trigger A trigger is activated/stopped by the user command

TRIGGERNOW/STOPTRIGGER sent either from the
console or remotely from a server

After Event A trigger is activated after recording of any event file
After Startup First trigger is activated after the instrument startup
Date and Time First trigger is activated at the defined date/time
Hardware Trigger The trigger is activated by hardware

Duration, sec User selectable The duration the scheduled trigger will be active
Delay after event, sec User selectable If After Event is selected, then the time between the

end of the event to the beginning of the activation of
the preset trigger can be configured

Pre-event, sec User selectable If After Event is selected, duration of the pre-event
Post-event, sec User selectable If After Event is selected, duration of the post-event
First trigger time, year User selectable Date and time of the first trigger
First trigger time, month User selectable
First trigger time, day User selectable
First trigger time, hour User selectable
First trigger time, minute User selectable
Total number of triggers User selectable After reaching the configured number of triggers the

preset trigger will not be activated anymore
Stored channels User selectable Number of channels which should be stored into an

event file in case of a trigger
‘+’ and ‘-’ can be used to change the preset triggers
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Assigned channel name User selectable Depending on the number of stored channels differ-
ent sources can be selected. Select the source by
pressing ‘A’.

Table 13: Preset trigger configuration menu structure
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9.7 File Storage and Policy

It can be configured in the instrument how all the files should be treated.

9.7.1 In the Web Interface or by GeoDAS

• Go to Configuration → File Storage and Policy

Figure 68: File Storage Settings

• Parameters for the following file types can be configured (see Filetypes in Table 14)

▪ SOH - State of health information and requested data files

▪ LOG - System log files

▪ TRG - Events and PGM files

▪ RBF - Ringbuffer files

▪ MAN - Scheduled manual recordings

▪ MSC - Miscellaneous files

• See Table 14 for more information about the parameters which can be configured.
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9.7.2 Via Local Serial Console

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• To adjust the settings of the file storage, press ‘M’ ; the File Storage and Policy menu will appear.

Configuration | File Storage
A) System reserved space, Mb ........ 12 (0x0C)
B) Length of one RB file, minutes ... 10 (0x0A)
C) SOH and requested data files ..... ->
D) System log files ................. ->
E) Events and PGM files ............. ->
F) Ringbuffer files ................. ->
G) Scheduled manual recordings ...... ->
H) Miscellaneous files .............. ->

• Parameters for the following file types can be configured (see Filetypes in Table 14)

▪ SOH - State of health information and requested data files

▪ LOG - System log files

▪ TRG - Events and PGM files

▪ RBF - Ringbuffer files

▪ MAN - Scheduled manual recordings

▪ MSC - Miscellaneous files

• See Table 14 for more information about the parameters which can be configured.
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System reserved space User selectable Amount of memory reserved for the operating system
in [Mb]. Keep 12 Mb by default.

Length of one RB file User selectable Permanent data will be stored in ringbuffer files; here
the length of one ringbuffer file in minutes can be
specified. After this time the file will be closed and
a new one started.

Disk space quota User selectable Reserved memory on the SD/CF-Card for the SOH
files in [%]

If over quota Delete oldest files In case the reserved memory is full the oldest files
will be deleted first

Life time User selectable After the configured time in [days] the files will be
deleted from the SD/CF-Card

Transfer priority Never Transfer In case a lot of files have to be transferred, the priority
of the file upload can be configured here. If Never
Transfer is configured, then no files will be uploaded.

Low
Mid
High
Highest

Transfer order Newest first Most recent files are transferred first
Oldest first Most old files are transferred first

Delete transferred Yes Files will be deleted after upload to the server

Fi
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No Files will be not deleted after upload to the server

Table 14: File Storage and Policies menu structure

• Additionally the system log files can be compressed. This can be separately enabled under the menu
point D) System log files:

Compress files Yes Files will be sent gzip-compressed (.gz)
No Original text files will be sent (default)

• State of health and event files have two more configuration options:

Transfer protocol Standard (Custom) Default option. This protocol also is used to transfer
any other types of files.

HTTPS This option can be used to upload data files to the
HTTPS servers only. Downloads are not supported.

Directory for uploads User selectable Name of the directory on the HTTPS server where up-
loaded files will be placed
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9.8 Communication Parameters

This chapter explains how to set up the server parameters.

9.8.1 In the Web Interface or by GeoDAS

• Go to Configuration → Communication Parameters

Figure 69: Server parameters

• Tick the flag Contact remote servers to configure a connection to a remote server.

• Configure the number of servers to contact in the field Number of servers

• Then go to Server Parameters to adjust the parameters as shown in the Table 15.

• In case the instrument should act as Server for other GMS instruments, tick the flag Server mode for
other instruments and follow the steps as described in chapter 9.8.2.1



100 / 150
GMSplus User Manual

2023-10-02 / V25

Figure 70: Edit Communication Parameters
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9.8.2 Via Local Serial Console

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘N’ to get to the Communication Parameters menu to adjust the settings of the file storage. The
following menu appears:

Main Menu | Communication
A) Contact remote servers .................. Yes
B) Number of servers ....................... 1
C) Time interval, sec ...................... 10 (0x0A)
D) Maximum files per session ............... 10 (0x0A)
E) Connect if there are new files .......... Yes
F) Connect by requests from clients ........ Yes
G) Server Parameters ....................... ->
H) Server mode for other instruments ....... Yes
I) Port for incoming connections ........... 3456 (0xD80)
J) Secure authentication ................... No
K) Number of clients ....................... 1
L) Clients Parameters ...................... ->
M) SeedLink server ......................... Yes
N) Accept connections ...................... Yes
O) Try next server on any transfer error ... Yes

• The following parameters can be adjusted:
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Contact remote servers Yes The instrument connects to the configured data
server(s)

No The instrument does not connect to any data
servers

Number of servers User selectable Number of data servers. If the instrument cannot
connect to the first data server it will connect to
the second data server; if this one is down it con-
nects to the third and so on. Scanning of servers
stops after first successful connection.

Time interval, sec User selectable Interval of connection to data servers in seconds

Maximum files per session User selectable Maximum number of files, which will be uploaded
during one session. Although data servers
support concurrent connections, this parameter
helps distributing the load of data processing by
the server among several instruments.

Connect if there are new
files

Yes Instrument connects to the server if there are new
files recorded and ready to be transmitted.

No Instrument connects to the server if there are new
files recorded and ready to be transmitted. Instru-
ment does not connect to the server if there are
new files. It just connects periodically as defined
with the parameter Time interval.

Server IP Address User selectable IP address of the data server

Protocol Custom Default protocol of communication

HTTPS This protocol can be selected only if you upload
SOH and/or EVT files to HTTPS servers

Port User selectable If Custom: Communication port of the data server

Transfer timeout, sec User selectable Instrument gives up trying to contact the server
after the configured timeout in seconds.

Network triggers Yes Triggers are sent to the server for event detection
as described in chapter C.2

No Triggers are not sent to the server

Yes Instrument connects to the data through PPP linkConnect through PPP
link No Instrument does not connect to the data server

through PPP

Number of failures
to give up

User selectable Number of trials until giving up

Yes Instrument connects to the data through PPP linkKeep connected to the
server No

Server port for
permanent links

User selectable The port which should be used to keep the con-
nection between the server open

Always connect to this

server

Yes Instrument will always try connecting to this
server, even if a file has already been delivered
to another server

No Disable this function

Connect failures before User selectable Number of failure before displays network error
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Server mode for other

instruments

Yes The instrument acts as a data server for other in-
struments. See chapter 9.8.2.1 for more details

No The instrument does not act as a data server.

Connect by requests
from clients

Yes Instrument connects to the server if there are new
files recorded and ready to be transmitted.

No Instrument doesn’t connect to the server if there
are new files recorded and ready to be transmit-
ted.

Port for incoming User selectable Port for incoming connections.

connections Other instruments have to set the same port un-
der Server parameters

Secure authentication Yes Secure authentication (SSL encryption) enabled.

No Secure authentication (SSL encryption) disabled

Number of clients User selectable Number of clients that this server can used

‘+’ and ‘-’ can be used to change between the servers

Client IP Address User selectable IP of the client instrument which connects to this
instrument.

Client serial number User selectable Serial number of the client instrument. Use
000000 to allow instruments with any serial num-
bers to connect.

Transfer timeout, sec User selectable Network timeout in seconds.

Data forwarding Yes Data from the data server will be forwarded to the
client instruments and the other way round.

No Data will not be forwarded.

Network triggers Yes Triggers are sent to the server for event detection
as described in chapter C.2
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No Triggers are not sent to the server

SeedLink server Yes SeedLink server is enabled for all data chan-
nels, and data streams can be received by any
SeedLink client from the instrument’s IP.

No The instrument does not act as a Seedlink server.

Accept connections Yes Allows GeoDAS to connect to the instrument.
Works only if the IP address of the instrument is
known and reachable.

No Do not accept connections from new clients

Try next server on any

transfer error

Yes If Yes, In case of communication error contact the
next server out of the list of Configured Servers.

No Don’t try to contact the next server

Table 15: Communication Parameters menu structure

9.8.2.1 Instrument acts in the Server Mode

The instrument can be configured to act as a server. In this case other instruments can upload their files to
this instrument. The server-instrument can then forward the data to a main server by another communication
medium. For example, two instruments (clients) upload their files to the instrument-server, which forwards the
data to a GeoDAS server by the cellular modem.

The serial numbers and IP addresses of all client instruments must be configured in the server so that requests
from GeoDAS can be correctly forwarded.
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This setup is not recommended, as it creates a big load for the server instrument. Special care
must be taken during design and setup. Whenever possible, all instruments shall have a direct
communication path to the GeoDAS server.

9.8.3 Connection over PPP (Cellular Modem or Analog Phone Line)

If it is required to use a PPP link for communication of the instrument with the GeoDAS server, then the
configuration must be set accordingly in armdas (see chapter 9.8). It is also required to configure PPP for
selected ISP (Internet Service Provider). The ISP configuration settings are described in the following chapters.

The GeoDAS server must have a real static IP-address (please, consult with ISP to obtain such a service).
In this example, 62.15.87.98 IP-address will be used for the GeoDAS server. Server parameters must be
configured as described in chapter 9.8.3.3.

Automatic Detection of a Cellular Modem

This chapter can be skipped in case the PPP connection shall be done by the internal analog
landline modem.

• Switch on the instrument by pressing and holding the POWER button for 2 seconds.

• Press <Ctr> + ‘Z’ as soon the following message appears on the console to enter the test mode:

GMSplus s/n 100582. Firmware in the Linux image: 21.11.00
#################################################
###### Test and Initial Configuration Mode ######
#################################################
Press Ctrl+Z to enter the test mode.....

The following menu will appear (see chapter 10 for details):

---------------------------------------------------------------------------------------
Level Shortcut Password Description
---------------------------------------------------------------------------------------
User Ctrl+U None Basic operations only
Powerful User Ctrl+W None Also hardware options and pre-selected tests
Administrator Ctrl+A None Also manual tests and altering the FLASH memory content
---------------------------------------------------------------------------------------
Your level [U/W/A] or press B to boot now:

• By default, no passwords are set, so press ‘W’ to enter the Powerful User, and then ‘K’ to enter the menu
Instrument hardware parameters.

• The instrument will start the automatic detection of an external cellular modem. Please wait 10 seconds
till it is completed.

Loading hardware configuration...
Querying devices...
External modem power has been switched on
Please wait 10 seconds while the instrument tries to detect a cell modem
External modem power has been switched off

• Depending on the connected cellular modem, one of the following messages appears:

Fast USB Cell Modem detected (SIMCOM_SIM5216E), IMEI = 359769031661413

Basic Serial Cell Modem detected (Teltonika TM2), IMEI = 353976014060325

Depending on the configuration, a combination of both is also possible, for example:

Fast USB Cell Modem detected (SIMCOM_SIM5216E), IMEI = 359769031661413
Basic Serial Cell Modem is configured but Fast USB Cell Modem is detected.
Update configuration (Y/N)?
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• If the modem is currently not present, but will be used later then the configuration can also be adjusted
manually in the following menu by pressing ‘H’. Besides the two types listed above, an instrument may
have also an internal 3G modem, which is also found automatically.

Hardware Configuration Menu
A) Number of sensors ........... 1
B) Sensor parameters ........... ->
C) Standard Wi-Fi module ....... No

Lantronix Wi-Fi module ...... No
Rack mounted slave board .... No
Wireless time sync module ... No
Internal analog modem ....... No

H) Cellular Modem .............. Fast USB Cell Modem
Alarm interface ............. No
Seismometer control ......... No

K) Interconnection interface ... Disabled

• Leave the menu by pressing <ESC> and <Enter>, then ‘S’ to save the configuration.

9.8.3.1 The ISP Configuration for PPP

• To enter the APN, login and password of your mobile phone provider press ‘N’ to enter the menu Network
settings.

• Press ‘N’ until the following message appears to adjust the ISP settings for the internal analog phone
line (only if installed):

---- PPP Communication ----
Edit Analog Modem settings (Y/N)?:

• Press ‘Y’ and enter the phone number, login and password given by your internet service provider. Add
a T in front of the number for tone dial, or a P for pulse dial.

Edit Cell Modem settings (Y/N)?

• Enter the APN, login and password provided by our mobile phone provider.

APN of the service provider [gprs.swisscom.ch]:
Login []:
Password []:
Updating configuration...
PPP settings have been updated

• By entering a blank space ‘ ’ the field will be cleared.



106 / 150
GMSplus User Manual

2023-10-02 / V25

• Press <Enter> till the following menu appears and then press ‘5’ to start the instrument:

Bootloader Menu of the GMSplus s/n 100582
Access level: Powerful User

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
K - Instrument hardware parameters
N - Network settings
T - Battery installation dates
G - Signal strength of GSM network
--- Security ---

O - Set password
J - Reset all passwords

-->

In case of troubles with connection to the ISP, please contact the ISP support service.
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9.8.3.2 In the Web Interface or by GeoDAS

• Go to Configuration → Communication Parameters → Server Parameters

Figure 71: Server parameters

• Tick the flag PPP Enabled to configure a connection to a remote server via the external cellular or
internal analog modem.

9.8.3.3 armdas Configuration

To configure armdas, connect to instrument through serial console or from GeoDAS as described in chapter 9.

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 0
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
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• Press ‘N’ to enter the Communication Parameters

Main Menu | Communication
A) Contact remote servers ............. Yes
B) Number of servers .................. 1
C) Time interval, sec ................. 60 (0x3C)
D) Maximum files per session .......... 10 (0x0A)
E) Connect if there are new files ..... Yes
G) Server Parameters .................. ->
H) Server mode ........................ No
M) SeedLink server ..................... Yes
N) Accept connections .................. Yes

• Change Contact remote servers to Yes, then adjust the Server Parameters by pressing ‘G’

Main Menu | Communication | Server
A) Server IP Address ...................... 62.15.87.98
B) Protocol ............................... Custom
C) Port ................................... 3456
H) Transfer timeout, sec .................. 40 (0x28)
I) Network triggers ....................... No
J) Connect through PPP link ............... Yes
L) Number of failures to give up .......... 3 (0x03)
N) Keep connected to the server ............ Yes
O) Server port for permanent links ......... 54204 (0xD3BC)
P) Always connect to this server ........... Yes
Q) Connect failures before network error ... 0 (0x00)

• GeoDAS server IP address must be set as Server IP Address and port number for Port parameter such
as for server in GeoDAS configuration (see Figure 22).

• Connect through PPP link should be Yes.

• If the user wants to use two modems (analog and GSM) together, one of which is in a role of an alternate
link, then it is required to set Try alternate PPP link on failure to Yes. In this case, if the preferred modem
will fail after the Number of failures to give up, then alternate modem will be used to establish link.

• After these adjustments, exit from submenus by <ESC> key, save configuration with ‘C’ and restart
armdas by pressing ‘R’.

After the modem is powered it takes a while till it finds the network, therefore we recommend to set
the ‘Startup time for cell modem’ 16 to 60 seconds.
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9.9 Miscellaneous Parameters

The Baseline Correction, State of Health files, messaging and debugging can be adjusted in this menu.

9.9.1 In the Web Interface or by GeoDAS

• Go to Configuration → Miscellaneous Parameters

Figure 72: Miscellaneous Parameters
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Figure 73: Edit Miscellaneous Parameters

Adjust the parameters as shown in the Table 16.
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9.9.2 Via Local Serial Console

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘O’ to get to the Miscellaneous Parameters menu to adjust time synchronisation, offset detection,
and other settings. The following menu appears:

Main Menu | Miscellaneous
A) Offset detection time, sec ............... 10 (0x0A)
B) Offset correction time, sec .............. 5 (0x05)
C) Offset correction counts ................. 1 (0x01)
D) MiniSEED record length ................... 512
E) Extended MiniSEED format ................. Yes
H) State of health .......................... ->
I) Test configuration ....................... ->
J) Messaging and debugging .................. ->
K) Time synchronization ..................... ->
L) Instrument configuration options ......... ->
M) Time for sending daily logfile, hour ..... 0 (0x00)
N) Time for sending daily logfile, minute ... 0 (0x00)

• The following parameters can be adjusted in the Table 16.
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Offset detection time, sec User selectable Time in seconds, which the input values is mea-
sured after startup to define the offset. This ’static’
offset will then compensate all channels with acti-
vated offset compensation.

Offset correction time, sec User selectable The instrument continuously takes the average over
the number of seconds specified. If this value is pos-
itive it will subtract the number of Offset Correction
Counts defined below. If the value is negative, the
Offset Correction Counts will be added to the sig-
nals. This is only active for channels where the off-
set compensation is activated and is used to com-
pensate ’dynamic’ offset which changes over time
(E.g. because of temperature changes).

Offset correction counts User selectable The number of counts which will be added to the sig-
nal, respectively removed from the signal, depend-
ing on the signum of the continuously calculated av-
erage over the Offset Correction Time

MiniSEED record length User selectable Length of one data block inside the miniSEED file.
In most applications, the default value 512 shall be
kept.

Extended MiniSEED format No MiniSEED files do not include any additional in-
formation. This option shall be used only if you
face any problems in reading extended format of
miniSEED files with your customized software.

Yes (default) MiniSEED files include configuration and state of
health information, which is encapsulated into the
blockettes 2000. When you open such files with
GeoDAS, there is no need to enter LSB factors and
units. This feature is supported from GeoDAS ver-
sion 2.21.

Include SOH information

in miniSEED

Yes Include SOH information in each MiniSEED file as
Blockette 2000 record.

No (default) Do not include SOH information in each MiniSEED
file as Blockette 2000 record.

Include configuration

in miniSEED

Yes Include current config.xml information in each
MiniSEED file as Blockette 2000 record

No (default) Do not include current config.xml information in
each MiniSEED file as Blockette 2000 record
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SOH report type None No SOH file will be created

Standard SOH files will be created and uploaded to the server
according to the settings in chapter 9.7

SOH reporting interval,

days
User selectable If Standard selected, defines the interval between

the SOH reports in days, hours and minutes

SOH reporting interval,

hours
User selectable

SOH reporting interval,

minutes
User selectable

Time of the first Startup First SOH report will be created at startup

SOH report Random Time of the first SOH is random. This is to avoid all
instruments using the network at the same time.

User defined First SOH report will be created at the user defined
time.

First SOH report

time, hours
User selectable If User defined is selected, defines the hour and

minute of the first SOH report

First SOH report

time, minutes
User selectable

Activate alarm on Yes Activates an alarm relay in case of an error.

errors or No Alarm relay will not be activated in case of an error.

Activate alarm when

system is inactive

Yes Alarm relay is activated in case armdas is not run-
ning.

No Alarm relay will not be activated.

Error and inactivity AL1 Select the alarm relay if at least one of the condition

alarm output AL2 above is Yes

AL3
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Activate alarm on

errors

Yes Alarm relay is activated in case armdas is not run-
ning.

No Alarm relay will not be activated.

Activate alarm on

selected error only

Yes Selected alarm relay is activated on selected errors
only. See below options

No Selected alarm relay is activated on all errors.

Alarm on file- Yes Enable the alarm of filesystem errors

system errors No Disable the alarm of filesystem errors

Alarm on memory Yes Enable the alarm of memory errors

errors No Disable the alarm of memory errors

Alarm on timing Yes Enable the alarm of timing errors

errors No Disable the alarm of timing errors

Alarm on DSP Yes Enable the alarm of DSP errors

errors No Disable the alarm of DSP errors

Alarm on network Yes Enable the alarm of network errors

errors No Disable the alarm of network errors

Alarm on disk Yes Enable the alarm of disk errors

errors No Disable the alarm of disk errors

Alarm on aux Yes Enable the alarm of aux errors

errors No Disable the alarm of aux errors

Alarm on processing Yes Enable the alarm of processing errors

errors No Disable the alarm of processing errors

Alarm on misc Yes Enable the alarm of misc hardware errors

hardware errors No Disable the alarm of misc hardware errors

Monitor state of current

loop sensors

Yes It monitors the sensor offset for its valid range. If
sensor offset is outside of its valid range a sensor
failure error message will be issued.

No Disable the monitor state of the current loop sensor

Send SOH on changing Yes Enable send SOH on changing error state.

error state No Disable send SOH on changing error state

Send SOH on changing Yes Enable send SOH on changing warning state
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warning state No Disable send SOH on changing warning state
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Type of periodic sensor None No test pulse is generated

test Pulse Test pulse is generated periodically and automati-
cally, depending on the following settings

Sensor test interval,

days

User selectable Interval between two sensor tests

Time of the first test Startup First test will be done at start-up, next after the de-
fined interval.

Random Time of the fist test is random. This is to avoid, that
all instruments in a network are doing the test in ex-
actly the same moment and are not able to record
events normally at the same time.

User defined First test will be done at the user defined time.

First test report

time, hours

User selectable If User defined is selected, defines the hour and
minute of the first test report

First test report

time, minutes

User selectable

Activate alarms on

sensor test

Normal An alarm is activated only if an amplitude of the test
pulse is above the related threshlold.

Never The alarms are not activated on tests

Always An alarm is activated upon every test.

Record test files Normal A file is recorded only if an amplitude of the test
pulse is above the trigger threshlold.

Never Test files are not recorded

Always A file is recorded upon every test.

Prefix for names CAL_ Test files will be created with this prefix

Te
st
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of test files TRG_
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Console messages Yes Enable console message

No Disable console message

Debug: memory Yes Enable debug message: memory allocation

allocation No Disable debug message: memory allocation

Debug: system and Yes Enable debug message: system and processes

processes No Disable debug message: system and processes

Debug: flash memory Yes Enable debug message: flash memory

No Disable debug message: flash memory

Debug: configuration Yes Enable debug message: configuration

No Disable debug message: configuration

Debug: network links Yes Enable debug message: network links

No Disable debug message: network links

Debug: data streams Yes Enable debug message: data streams

No Disable debug message: data streams

Debug: data sources Yes Enable debug message: data sources

No Disable debug message: data sources

Debug: ring buffers Yes Enable debug message: ring buffers

No Disable debug message: ring buffers

Debug: event triggers Yes Enable debug message: event triggers

No Disable debug message: event triggers

Debug: time Yes Enable debug message: time synchronisation

synchronisation No Disable debug message: time synchronisation

Debug: file manager Yes Enable debug message: file manager

No Disable debug message: file manager

Debug: cryptographic Yes Enable debug message: cryptographic info

info No Disable debug message: cryptographic info

Debug: hardware related Yes Enable debug message: hardware related info

info No Disable debug message: hardware related info

Debug: external hardware Yes Enable debug message: external hardware

No Disable debug message: external hardware

Debug: JMA early Yes Enable debug message: JMA early warning

M
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warning No Disable debug message: JMA early warning

Enable autodetection

of the instrument

Yes Instrument can automatically be found by GeoDAS
in the LAN.

No Instrument can not automatically be found by Geo-
DAS.
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Time for sending daily

logfile, hour

User selectable If transfer is activated as described in chapter 8.7,
the daily logfile will be sent to the server at this hour
of the day. This can be adjusted to avoid that all
instruments send the logfile at exactly the same time

Time for sending daily

logfile, minute

User selectable

Keep modem

always powered

Yes Keep the external cell modem always powered

No Turning it on only when required

Startup time for

cellular modem

User selectable Time the system will wait for the Cellular modem to
start up

Connect time for

cellular modem

User selectable Time the system will wait for the Cellular modem to
connect to the provider

DSP mode set delay [s] User selectable After startup, the instruments internal clock is
roughly synchronized against a foreign network time
source (NTP) and time is pushed to the DSP. During
this initial time period the DSP will use this foreign
time to do sampling while synchronizing to an exter-
nal time-source such as GPS. After this initial time
period the DSP will be switch to the external time-
source.

DSP sync behaviour Dilate The DSP is supposed to drift against to correct time,
i.e., an offset of the reported and actual time is noted
in each record of the mini-seed file. No interrup-
tions of waveform processing occurs but it can take
some hours until synchronization has been com-
pleted. This mode is ideal for building monitoring.

Wrap Upon switchinhg the time-source, the DSP stops
waveform processing, re-synchronizes the ADC
clocks and restarts waveform processing. This
mode is only recommended when long drift times
are undesirable.

DSP snap window [ms] User selectable Specifies the maximum allowed time difference the
DSP can drift to obtain synchronization with an ex-
ternal time-source, in case the instrument was run-
ning for a long period of time on its internal RTC,
e.g., after GPS failure. If the time difference be-
tween the DSPs internal clock and the external time
source is larger than the specified amount, the DSP
will perform a time-warp and waveform processing
will be restarted.

Waveform processing Slow Once per second waveform processing is executed
which allows sampling rates as low as 1 SPS.

style Standard This is the default mode on all GeoSIG instruments
and supports sampling rates as low as 5 SPS.
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Real-time The scheduler guarantees an execution rate of 50
times per second for waveform processing making
this mode ideal for applications in the early warning
field.

Table 16: Miscellaneous Parameters menu structure
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9.9.3 Time synchronization

The system has a Real Time Clock (RTC) that maintains internal time when the unit is turned off. During normal
operation the RTC is responsible for providing the most accurate time possible to the system and performing
time synchronization with other available external time sources as:

• GPS time code receiver on the GPS interface

• NTP (Network Time Protocol) server from the wired or wireless Ethernet interface

• NET1PPS time signal over 433 MHz radio module

It also keeps under control the sampling clock of the ADCs and self-calibrates its oscillator against temperature
and aging when it is connected with an accurate external time signal.

The DSP receives a continuous 1 PPS signal from the RTC with the best possible accuracy of the RTC,
including temperature compensation, based on the saved coefficients. The DSP will sync the sampling clock
with this 1 PPS signal to have accurate sample timing.

The following parameters can be adjusted in the Table 17.

Time source RTC RTC is not synchronizing itself to any source. It will
keep it’s own time which might differ from other de-
vices or the actual time.

GPS RTC is synchronising to the, optionally, connected
GPS, which allows very good time synchronisation
between devices with other GPS enabled devices.

NTP RTC is synchronising to a NTP server.

AUTO RTC synchronises to NTP in case GPS is not avail-
able. This is a good option for GPS and Ethernet
enabled devices, where the GPS reception might be
lost from time to time.

NET1PPS RTC is synchronizing to the 1PPS signal. This sig-
nal can be received by the optional 433 MHz wire-
less module or the interconnection network. (This
option needs a device which is broadcasting its time
by 433 MHz.)

NTP server 1 User selectable IP of the primary NTP Server.

NTP server 2 User selectable IP of the secondary NTP Server.

NTP server query

interval, sec

User selectable Interval time in seconds the NTP server is contacted
by the instrument.

NTP requests in

a row

User selectable Every time the instrument is contacting the NTP
server the configured number of requests will be
sent. For service and advanced user only, only
change the default value if you know what you are
doing.

NTP query intervals

per RTC update

User selectable Specifies the number of NTP synchronizations until
the RTC is updated. The default is to update the
RTC after each synchronization with a NTP server.

NTP synchronisation

timeout warning, min

User selectable Raise a warning if synchronization with the NTP
server was not possible for the given amount of time.
Default is 240minutes.

NTP synchronisation

timeout error, hours

User selectable Raise an error if synchronization with the NTP
server was not possible for the given amount of time.
Default is 12hours.
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NTP maximum error,

sec

User selectable If the current RTC time differs more than this time
limit in [seconds] from the NTP time, the RTC time
will make a time jump to the NTP time. Otherwise
the time will be tuned slowly. For service and ad-
vanced user only, only change the default value if
you know what you are doing

GPS reception timeout,

min

User selectable If GPS signal is lost, after this time in [minutes] the
RTC will change its synchronisation method to NTP

GPS check interval in

NTP mode, min

User selectable If the time synchronisation is in the ’Auto” mode, and
the RTC is synchronized to the NTP (because the
GPS signal has been lost) the instruments checks in
the configured interval if the GPS is available again
(minutes)

GPS check interval in

NTP mode, sec

User selectable If the time synchronisation is in the ’Auto” mode, and
the RTC is synchronized to the NTP (because the
GPS signal has been lost) the instruments checks
for the configured time duration if the GPS is avail-
able again (seconds))

GPS power mode Always on The power to the GPS receiver is on continuously

Duty cycle To reduce the instrument power consumption, the
GPS receiver is activated for a user selectable pe-
riod of time and than switch it off

GPS power-on

duration, min

User selectable Minutes to energize the GPS receiver to obtain the
time synchronization. Minimum 60 minutes are rec-
ommended

GPS power-off

duration, hours

User selectable Hours to power off the GPS receiver, after this pe-
riod of time it will be activated again for the time set
above. Minimum 1 hour is recommended

Turn GPS off on low

battery voltage

Ignore battery voltage Enable power to the GPS receiver regardless the
batteries voltage

Monitor internal battery Reduce the instrument power consumption by turn-
ing off the GPS receiver when the internal battery
voltage is below a certain threshold.

Monitor External battery Reduce the instrument power consumption by turn-
ing off the GPS receiver when the external battery
voltage is below a certain threshold.

GPS off on both batteries Reduce the instrument power consumption by turn-
ing off the GPS receiver when the internal and the
external battery voltages are both below a certain
threshold.

GPS off on either batteries Reduce the instrument power consumption by turn-
ing off the GPS receiver when the internal or the
external battery voltages is below a certain thresh-
old.

Power-off voltage

of internal battery, V

User selectable Voltage threshold of the internal battery to turn off
the GPS receiver

Power-off voltage

of external battery, V

User selectable Voltage threshold of the external battery to turn off
the GPS receiver

Power-on voltage is

higher by value, V

User selectable ysteresis above the turn-off value, to turn on the
GPS receiver.
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RTC watchdog timeout,

sec

User selectable If armdas is not running for this amount of time,
there will be a hard reset of the device. Only change
this setting if you really know what you are doing!
Wrong settings could render your device unusable
without GeoSIG support. The value of 0 disables
the Watchdog.

Send SOH upon RTC

status change

Yes In case RTC status changes, a SOH message will
be uploaded to the server.

No In case RTC status changes, no SOH will be send

Offset to UTC, minutes User selectable Difference between the local time and Coordinated
Universal Time (UTC). The default is to use UTC as
time reference.

Use IANA timezone Yes Use Time Zone to set instrument time

mapping No Don’t use Time Zone to set instrument time

Use ISO timestamp Yes Use ISO 8601 in all files name including offset

formatting No Don’t use ISO 8601 in all files name including offset

Table 17: Time Synchronization Parameters Menu Structure

9.9.3.1 Temperature compensation

RTC uses the internal temperature sensor of the micro-controller to define the current operating temperature.
When good time synchronization occurs, typically using a GPS, the RTC checks its own drift against the signal
of the GPS and adds the correction coefficients in a trim table. With a NTP time source, the accuracy is worse
but the same process occurs with more averaging and on longer period of time.

During factory test, all the coefficients are initialized to the room temperature coefficient using a GPS. After
installation on site, the unit will learn the correction parameters according to the ambient conditions at site and
also according to the aging of the oscillator.
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9.10 Sensors and Virtual Channels

The virtual channels are basically that one can add more channels than the physical ones. Virtual channels
can be used for:

• Have a filtered copy of another physical channel

• Have a lower sampling rate of another physical channel

• Have the vector sum of 2 or 3 channels

• Math function like integration and derivation

They can be used to save in the RBF only the decimated data and not the higher sampling rate data, trigger
on a specific filtered data, etc

This chapter explains how to set up the virtual channels.

9.10.1 In the Web Interface or by GeoDAS

• Go to Configuration → Miscellaneous Parameters

Figure 74: Sensors and Virtual Channels
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Figure 75: Edit GeoSIG Options

9.10.2 Via Local Serial Console

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
P) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘P’ to get to the GeoSIG Options menu to enter Product key for EEW applications, enable/disable
and configure waveform injection and other GeoSIG specific features.
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Main Menu | Sensors and virtual channels
A) Number of virtual sensors ........... 1
B) Settings of sensors ................. ->
C) Support wireless sensors ............ Yes
D) Max. number of wireless sensors ..... 10 (0x0A)
E) Minimum request interval, ms ........ 2 (0x02)
F) Transmit timeout, sec ............... 5 (0x05)
G) Discovery interval, sec ............. 20 (0x14)
H) Routing info update interval, sec ... 30 (0x1E)
I) Node response timeout, sec .......... 600 (0x258)
J) Delay after requests, ms ............ 200 (0xC8)
K) Max. number of virtual channels ..... 10 (0x0A)
L) Store data into ringbuffer files .... Yes
M) Data acquisition mode ............... Permanent
N) Duration of raw data files, min ..... 20 (0x14)
O) Process only devices with names ..... [all names]
P) Process only devices with MACs ...... [all MACs]

• The following parameters can be adjusted:

Number of virtual sensors User selectable Choose the number of virtual sensors [1-256]

‘+’ and ‘-’ can be used to change between the virtual sensors

Unique sensor ID User selectable Name of unique sensor ID

Measurement type User selectable Name of the type of measurement

Number of channels User selectable Choose the number of channels [1-256]

‘+’ and ‘-’ can be used to change between the virtual channels

Assigned channels name User selectable Assign channel name to a virtual sensor

Quantity User selectable Name of the type of measurement

Minimum value User selectable Type minimum value
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Maximum value User selectable Type minimum value

Support wireless sensors Yes Enable wireless sensors

No Disable wireless sensors

Transmit timeout, sec User selectable Put transmit timeout in second

Discovery interval, sec User selectable Put discovery timeout in second

Routing info update interval, sec User selectable Put Routing info update interval in second

Node response timeout, sec User selectable Put Node response timeout in second

Max. number of virtual channels User selectable Choose the maximum of number of channels

Store data into ringbuffer files Yes Enable the store of data into ringbuffer files

No Disable the store of data into ringbuffer files

Data acquisition mode Permanent Data acquisition is permanent

Trigger-based Data acquisition is trigger-based

Duration of raw data files, min User selectable Put Duration of raw data file in minutes

Process only devices with names User selectable [all names] allows all names

Process only devices with MACs User selectable [all MACs] allows all MACs address

Table 18: Sensor and Virtuals Parameters menu structure
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9.11 GeoSIG Options

This menu and the functions under it are subject to change. The user should not use or rely on any
features under this menu without consulting GeoSIG.

9.11.1 In the Web Interface or by GeoDAS

• Go to Configuration → GeoSIG Options

Figure 76: GeoSIG Options

Figure 77: Edit GeoSIG Options
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9.11.2 Via Local Serial Console

Main Menu
A) Station description ............. Demo GMSplus
B) Station code .................... DEMO
C) Location description ............ Switzerland
D) Seismic network code ............ CH
E) Number of Channels .............. 3
F) Number of Output Streams ........ 1
G) Number of Trigger Sets .......... 1
H) Number of Preset Triggers ...... 1
I) Channel Parameters .............. ->
J) Stream Parameters ............... ->
K) Trigger Parameters .............. ->
L) Parameters of Preset Triggers ... ->
M) File Storage and Policy ......... ->
N) Communication Parameters ........ ->
O) Miscellaneous Parameters ........ ->
Q) Sensors and Virtual Channels .... ->
S) GeoSIG Options .................. ->

• Press ‘S’ to get to the GeoSIG Options menu to enter Product key for EEW applications, enable/disable
and configure waveform injection and other GeoSIG specific features.

Main Menu | GeoSIG Options
A) Enable real-time waveform message queue .... No
B) Product Key (required for early warning) ... XXXXX-XXXXX-XXXXX-XXXXX-XXXXX
C) Waveform Simulator ......................... ->

• The following parameters can be adjusted:

Enable real-time waveform
message queue

Yes Enable the real-time waveform message queue.

No Disable the real-time waveform message queue.

Product Key (required for
early warning)

User selectable If purchased, enter the product key for early warn-
ing options. The product key is of the form XXXXX-
XXXXX-XXXXX-XXXXX-XXXXX.

Enable waveform
source

User selectable Enable waveform inject from files (0...disable, 1...first
file, 2...second file, 3...third file.

Source 1 User selectable Path for first waveform source.

Source 2 User selectable Path for second waveform source.W
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Source 3 User selectable Path for third waveform source.

Table 19: GeoSIG options menu structure
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9.12 Other Options in the Instrument Main Menu

Next to the edit of the instrument configuration, there are other actions possible from the main menu shown
below:

GMSplus s/n 100582 version 21.11.00
Main menu:
C - Configuration
M - Messages ->
S - Shell command
L - List firmware images
X - Display errors (0) and warnings (0)
W - Clear errors and warnings
F - View/reset RTC trim values
T - File statistics
G - View RTC status
P - View GPS information
H - Set RTC time
U - User request
R - Restart
Q - Quit

Action or command Description

C Configuration Change of the configuration of the instrument. See chapter 9
for details.

M Messages → Possible to configure what kind of messages are shown in
the console.

S Cell command Allows executing a Linux shell command from armdas. For
advanced users only.

L List firmware images Displays the list of firmware images and configuration stored
in the non-volatile memory of the instrument. There are two
copies of each type of firmware, except for the Bootloader,
which has only one image.

X Display errors (n) and warnings (m) Shows present errors and warnings.

W Clear errors and warnings Clears all errors and warnings.

F View/reset trim values Shows trim values of the RTC. Trim table can be erased as
well. For advanced users only.

G View RTC status Shows the actual state of the real time clock and whether the
RTC is synchronized to NTP or GPS.

P View GPS information Shows the actual GPS information if the unit is equipped by
the GPS receiver.

H Set RTC time Allows setting the time of the instrument manually. Keep in
mind, that if a GPS is connected or a NTP server is config-
ured, the time will be synchronized to them after a while, not
immediately.

U User request See chapter 9.12.1 for details.

R Restart Restarts the instrument, e.g. after a change of the configura-
tion.

Q Quit Stops armdas data acquisition and exits to the Linux console.
For advanced users only.

Table 20: Other options in the main menu
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9.12.1 User Requests

Several actions can be initiated by the user:

• In the main menu press ‘U’ to enter the User request menu; type HELP to see all the possible commands.

GMS-XX s/n 100710 version 20.00.97
Main menu:
C - Configuration
M - Messages ->
S - Shell command
L - List firmware images
X - Display errors (1) and warnings (0)
W - Clear errors and warnings
F - View/reset RTC trim values
T - File statistics
G - View RTC status
P - View GPS information
H - Set RTC time
U - User request
R - Restart
Q - Quit

Command or HELP for more information --> help

The list of all supported user requests (commands) along with their description is provided in the table below.

Action or command Description

Data requests, triggering:

GETEVT YYYY-MM-DD HH:MM:SS N The instrument creates an event with the length of N seconds from
the ringbuffer data, starting from the indicated date and time and
uploads the data to the server if configured (see chapter 9.8).

TRIGGERNOW [trigger_name] Activate a manual trigger to start recording, the manual trigger
must be configured as described in the chapter 9.6

STOPTRIGGER [trigger_name] Deactivates the manual trigger

Status and information:

GETSOH The instrument generates a SOH file with the current state-of-
health information and uploads to the server if configured (see
chapter 9.8).

GETLOG The instrument uploads today’s logfile to the server.

SETMSG flags Enables/disables debug log messages. For service only, do
not changeCLRMSG flags

Service and recovery:

LASTDT YYYY-MM-DD HH:MM:SS Set date and time of the last transferred file

The instrument saves the date and time of the latest uploaded file
and will not upload any file which is created before this date and
time. Under normal conditions this will be never the case. But if
the time is changed backwards by the user - e.g. from 10:00 to
06:00 - the instrument will not upload any data till 10:00 again.
So the time of the last transferred file can be adjusted here and
should be set to 06:00 in this example.

FORMAT Formats the data storage media. All data will be lost, and in-
strument will be restarted.

REBOOT Performs full reboot of the instrument

RESETERR Reset errors and warnings of the instrument



128 / 150
GMSplus User Manual

2023-10-02 / V25

GETTRIM The instrument will upload a SOH file containing the actual values
from the RTC trim table. The latest SOH file can be found under
\\GeoDAS_DATA\StatusFiles\InfoSOH.xml

CLEARTRIM The instrument will clear the RTC trim table

TCAL <Tcur> Calibration of the internal temperature sensor by applying the ac-
tual temperature in ° C. The RTC uses temperature to learn.

SETDEFCFG Makes the current instrument configuration as user default one.
Whenever you change parameters of the instrument, they are
saved in the non-volatile instrument memory as Current Config-
uration, and used to set all parameters of the data acquisition at
startup. But if due to some reason the current configuration gets
corrupted, and the instrument cannot load or cannot process it,
the Default Configuration file, which is created by this command,
will be used instead. Note that Default Configuration is compiled
from the actual parameters of the running system, and therefore
it is already approved by the instrument and is supposed to be
correct. Thus, we recommend sending this command to the in-
strument after you are sure that your instrument is started with the
latest configuration correctly and everything works as expected.

The default configuration can also be set and restored in the Web
Interface, see chapter 8.3.2

RSTUSRDEF Reset the instrument to its user default configuration.

DELETE <file_prefix or ALL> [YYYY-
MM-DD [HH:MM]]

Delete one group of files or all groups of files from the compact
flash card. One can request to delete only files that are older than
the specified date (and optionally time).

Sensor test and calibration:

TSTSENSOR 1 [REC=TRG|YES|NO]
[ALARM=TRG|YES|NO]

The instrument generates a sensor test pulse. Optional parame-
ters REC and ALARM specify whether a file will be recorded dur-
ing test and whether an alarm will be generated in case an alarm
board is present. Parameters TRG, YES and NO correspond to
the modes Normal, Always and Never described in the section
9.9.2

REMOVEDC Remove offsets from signals

Others:

CANCEL Leave the menu

Table 21: User requests

In case the instrument has a Seismometer Control Board installed, then additionally the following user requests
are possible under Sensor test and calibration:

SLOCK Performs a mass locking of the connected seismometer

SUNLOCK Performs a mass unlocking of the connected seismometer

SCENTRE Perform a mass centring of the seismometer

The same request can also be done from GeoDAS by choosing ‘Send a Request’ from the ‘GMS
Communication Interface’. See chapter C.3.4 for details.
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10 Test and Configuration Menu

The test and configuration menu can only be accessed locally at the instrument over the serial cable.

• Switch on the instrument by pressing and holding the POWER button for 2 seconds.

• Press <Ctr> + ‘Z’ as soon as the following message appears on the console to enter the test and
configuration mode:

Press Ctrl+Z to enter the test mode................

• The test and configuration menu has three access levels.

---------------------------------------------------------------------------------------
Level Shortcut Password Description
---------------------------------------------------------------------------------------
User Ctrl+U None Basic operations only
Powerful User Ctrl+W None Also hardware options and pre-selected tests
Administrator Ctrl+A None Also manual tests and altering the FLASH memory content
---------------------------------------------------------------------------------------
Your level [U/W/A] or press B to boot now:

The test and configuration menu has three access levels as outlined above: User, Powerful User and Ad-
ministrator, and each level can be protected by a password. Instead of pressing <Ctrl>+‘Z’, one can press
<Ctrl>+‘U’, <Ctrl>+‘W’ or <Ctrl>+‘A’ to bypass the above messages and to proceed directly to a menu of the
desired level. The Administrator has access to the most complete menu but the majority of functions are not
used for the standard instrument operation, and therefore they are not described here in detail. The useful
options are highlighted and described below.

Access level: User

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
N - Network settings

--- Security ---
O - Set password

-->
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Access level: Powerful User

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
K - Instrument hardware parameters
N - Network settings
T - Battery installation dates

--- Security ---
O - Set password
J - Reset all passwords

-->

Access level: Administrator

--- Flash Images and Boot Options ---
L - List flash images
Q - Reset instrument configuration to the user default
V - Reset instrument configuration to the factory default
5 - Boot now
X - Reboot the instrument
Y - Power off

--- Hardware Setup and Monitor ---
K - Instrument hardware parameters
N - Network settings
T - Battery installation dates

--- Test Functions ---
P - Test RTC
M - Test GPS

--- Security ---
O - Set password
J - Reset all passwords

-->
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10.1 Flash Images and Boot Options

L List flash images Lists all the current firmware in the image

Q Reset instrument configuration
to the user default

Forces the instrument to load the user default configuration. See
description of the command SETDEFCFG in the chapter 9.12.1

V Reset instrument configuration
to the factory default

Forces the instrument to load the factory default settings

5 Boot from the default image Exits the test and configuration menu and starts the instrument
normally

X Reboot the instrument Forces the watchdog to completely restart the instrument

Y Power off Forces the watchdog to switch off the instrument

10.2 Hardware Setup and Monitor

K Instrument hardware
parameters

Checks what HW is installed in the instrument and adjust the
number of sensors

N Network settings Enters the menu to adjust the network settings (dynamic or
fixed IP, subnet and gateway, DNS servers), the PPP settings,
enable/disable the SSH and Web Interface and configure the
backup server. For details see chapter 5.2

T Battery installation dates Whenever you install a new battery, you must set the installation
dates using this menu.

10.3 Test Functions

P Test RTC Runs an automatic check of the RTC

M Test GPS Allows user to the see the NMEA messages of the GPS and to
initialise the GPS receiver.

10.4 Security

O Set password Sets the password to prevent unauthorised access to the current
level of the test and configuration menu.

J Reset all passwords Resets all passwords below the levels of access

• Leave the test and configuration menu by pressing ‘5’ or ‘Y’
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10.5 Comparison of User Permissions
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Flash Images and Boot Options
List Flash images X X X
Reset instrument configuration to the user default X X X
Reset instrument configuration to the factory default X X X
Boot now X X X
Reboot the instrument X X X
Power off X X X
Hardware Setup and Monitor
Instrument hardware parameters X X
Network settings X X X
Battery installation dates X X
Test Functions
Test RTC X
Test GPS X
Security
Set password X X X
Reset passwords X X

Table 22: Comparison of test and configuration menu users
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11 Firmware Upgrade

All the firmware for

• Linux operating system

• armdas firmware

• DSP

• RTC

can be upgraded by the user by using GeoDAS as described in the following chapters. The firmware will be
released only as a complete package, containing all the firmware listed above. Please see www.geosig.com
→ Support → Downloads to download the latest firmware release package.

Even if there is no known case of data loss during the upgrade, we recommend backing up all
recorded data and the configuration before starting the upgrade.

After any firmware upgrade, the configuration and the correct function of the instrument should be
fully verified.

If the instruments are configured to contact a server, it is possible to upgrade all or specific instruments remotely
using GeoDAS. Before trying to upgrade remotely, be sure the instruments have a working network connection
to the server. To proceed with the firmware upgrade, please take the following steps:

• Make a right click on the Station in the GeoDAS main window and select Instrument Control. . .

Figure 78: Select Instrument Control

• A list box will appear.

Figure 79: instrument Communication Interface
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• Select the item Send an Upgrade

• Press on the button Browse . . . to select the required firmware. Select a firmware container with the
extension *.gsfw or a *.zip archive containing several update packages.

• If the file is selected, press the Send button. GeoDAS identifies the firmware and asks for confirmation.
Please double check that the correct firmware has been selected.

• Upon pressing the Yes button, the firmware will be placed in the Outgoing directory, so that it can be
collected by the instrument(s) upon next connection.

Figure 80: Pending upgrade on the server

• As soon as the instrument has downloaded the new firmware, the text Pending: xxx.gsfw disappears.
The instrument will verify the firmware and once the upgrade process is finished, the instrument will
restart.

When the instrument software receives such a file it checks the actual version and, only if the file contains
more recent firmware than the existing one, it will start the upgrade. After the upgrade, the new firmware will
be in “trial” mode and a reboot is done. If the reboot and instrument operation is correct, the new firmware
will be accepted. If the instrument reboots through its watchdog because the firmware was faulty, the previous
firmware version will be used and the system will be restored to its state before the upgrade.

Downgrades to the older firmware versions might be required in some specific cases. This is possible, too.
Please contact GeoSIG support for the exact procedure of such downgrade.
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Appendices
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Appendix A Connector Pinouts

A.1 POWER Connector

Pin Description
1 External power supply, 15 VDC
2 GND
3 External battery 1, 12 VDC
4 GND
5 Shield

Mating Type: Binder Series 423, cable connector female, 5 pole

A.2 ETHERNET Connector

Pin Description
1 Detection if cable is connected, to be connected to GND inside the cable
2 RXD+
3 RXD-
4 TXD+
5 TXD-
6 Shield / GND
7 Shield / GND

Mating Type: Binder Series 423, cable connector female, 7 pole

A.3 SERIAL Connector

Pin Description - COM Pinout
1 TXDa COMa: ttyS2 or ttyS3
2 RXDa Serial data streaming and cellular modem
3 RTSa
4 CTSa
5 TXDb COMb: ttyS0
6 RXDb Configuration Console
7 Power, 12 VDC For external cellular modem only
8 GND
Pin Description - USB Pinout
1 USB Device Vbus USB Device Connector
2 USB Device D+
3 USB Device D-
4 GND
5 USB Host D+ USB Device Connector
6 USB Host D-
7 USB Host Vbus
8 GND

Mating Type: Binder Series 423, cable connector male, 8 pole

1Cannot be used together with an internal battery
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A.4 GPS Connector

Pin Description
1 TXD
2 RXD
3 N/C
4 GND
5 1PPS
6 Power, 12 VDC
7 GND

Mating Type: Binder Series 423, cable connector male, 7 pole

A.5 SENSOR Connectors

Pin Description
A X+
B X-
C Y+
D Y-
E Z+
F Z-
G S_Test, Calibration Test Pulse
H GND
J Power, 12 VDC
K GND
L S_Mode, Calibration Enable
M Analog AGND

Mating Type: Binder Series 423, cable connector male, 12 pole

A.6 INTERCONNECTION Connector

Pin Description Seismometer Control Option
1 Trigger + /Lock
2 Trigger - /Center
3 Time Synchronisation + Mass Position E/W
4 Time Synchronisation - /Unlock
5 RS-485 + (not used) Busy Signal
6 RS-485 - (not used) GND
7 N/C Mass Position N/S
8 GND Mass Position V

Mating Type: Binder Series 423, cable connector female, 8 pole

A.7 MODEM Connector

Pin Description
1 Line a
2 Line b
3 N/C
4 N/C
5 N/C
6 HGND

Mating Type: Binder Series 423, cable connector female, 6 pole
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A.8 ALARM Connector

Standard Configuration
3 isolated relay contacts

Optional Configuration
4 relay contacts with
common pin

Mating Type: Binder Series 423, cable connector male, 6 pole

The contacts are suitable for a low voltage control. In case large load must be switched then
external relays must be implemented. Max rating of the internal relay is 125 V / 250 mA.
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Appendix B Remote Access to the Instrument over SSH

The following chapter is for advanced users only.
Warranty will be void if something is damaged by user during changes in the root file system.

Secure Shell (SSH) is a network protocol for secure data communication, remote shell services or command
execution and other secure network services between two networked computers that it connects via a se-
cure channel over an insecure network: a server and a client (running SSH server and SSH client programs,
respectively).

The armdas console cannot be shown through the SSH. This is a limitation of the armdas firmware.

The instrument supports all types of remote access through SSH. User can connect from his PC by SSH client
program to the SSH server of the instrument. Simple SSH client program can be used for this purpose. Use
root as login and swiss as the password, as shown:

Login: root
Password: swiss

Sign ‘#’ is a command prompt where you can type console commands.

The password can be changed by passwd command.

Warranty will be void in case password is changed and forgotten.

B.1 SSH Clients for Linux OS

For the Ubuntu or other Debian-like GNU/Linux OS, SSH client program, with command line interface, can be
installed by command

$ sudo apt-get install openssh-client

To login into the instrument console, “ssh root@192.168.1.10” command can be issued from any terminal
emulator as following figure shows:

Figure 81: Command line SSH client at terminal emulator
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Alternatively, the PuTTY SSH client with GUI interface can be installed by command

$ sudo apt-get install putty

This software can be found in a menu Applications → Internet → PuTTY SSH Client and its configuration
dialog looks like:

Figure 82: Configuration window of PuTTY

IP address 192.168.1.10 from examples above should be changed to the real IP address of the instrument.

B.2 SSH Clients for Windows OS

The same PuTTY as for GNU/Linux OS or alternatively TeraTerm software can be used for Windows OS to
have remote access to the instrument by means of SSH.

Its connection window is shown below

Figure 83: TeraTerm Connection Window

The PuTTY software for Windows OS operates the same as PuTTY for Linux OS.

The PuTTY software can be downloaded from https://www.chiark.greenend.org.uk/~sgtatham/putty/

The TeraTerm software can be downloaded from http://ttssh2.osdn.jp/

https://www.chiark.greenend.org.uk/~sgtatham/putty/
http://ttssh2.osdn.jp/
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B.3 SFTP access for Windows OS

WinSCP is an open source free SFTP client for Windows. Its main function is the easy file transfer between a
local computer and the instrument.

Figure 84: WinSCP login window

To connect to the instrument put the IP address of the GMSplus and enter the following user name and pass-
word:

Login: root
Password: swiss

Figure 85: Explorer mode of WinSCP when connected to the instrument

It is then possible to browse through the available data on the instrument and copy files from or to the computer.
The file structure is described in the following chapter.

The WinSCP can be downloaded from here: https://winscp.net/eng/download.php

https://winscp.net/eng/download.php
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B.4 File Structure of the Instrument

On the instrument the files are organized as following

\media\mmcblk01\. . . in case an SD card is installed
\media\sda1\. . . in case a CF card is installed
. . . Data\ Event files
. . . Ringbuffers\ Permanent recording files
. . . Logfiles\ Log files of armdas

The filenames contain the following information

XXX_SNSNSN_YYYYMMDD_HHMMSS.ext
Extension .ext Depending on file type

.msd MiniSEED containing waveform data

.xml SOH and PGM information

.txt LOG and ERR files

.bin MMA packets (special for Korean market)

Time HH Hour
MM Minutes
SS Seconds

Date YYYY Year
MM Month
DD Day

S/N SNSNSN Six digit serial number of instrument

Type XXX Depending on file type
TRG Event trigger
USR User request
TTT Time table trigger
CAL File with test pulse
MAN Manual trigger
RBF Permanent recording
LOG Log files
SOH State of Health information
PGM PGM information of event
ERR Error messages
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Appendix C GeoDAS Settings

C.1 Configuration of Stations

To be able to communicate with the instrument, GeoDAS must act as a server. This chapter should help to find
the correct settings.

• Open GeoDAS and Go to the menu Settings → Configure Stations. . . , the following window will
appear:

Figure 86: Configuration Stations

Area Topic Description

1 Configured GSR Stations Details about the configured GSR-xx and GCR-xx stations. Check
separate GeoDAS Manual for details.

2 Instrument Stations Details about the configured instruments. All instruments connected
to the same network will be listed in grey.
Station name can be changed by a double click on the field you
want to change.
The column Instrument and Serial Number shows the instrument
type and its serial number.
The Firmware column shows the firmware version of the main data
acquisition firmware.
The Public IP shows from where the instrument is connected to the
server. In case the instrument is behind a router or firewall, then this
IP address will be shown. Network settings can be done according
to chapter 7. If one wants to connect manually to the instrument,
then GeoDAS will try the address and port listed under Address.
The last column in the table is Status, which is indicated by one or
more letters, which are the following:

• N - New instrument
• C - already Configured earlier
• A - Altered parameters
• R - actual settings were Received from the instrument

3 Server Settings For configuration of the Server, see chapter C.2
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C.1.1 Add a new Instrument

All instruments connected to the same network will be listed in grey. To add one of these stations into the
current configuration do the following:

• Select the instrument and make a right click

• Click on Add Station to Current Configuration

• Press OK

Figure 87: Add Station to Current Configuration

If the instrument is not in the local network and cannot directly be accessed, then press Add New Station
Manually and enter the serial number of the instrument.

C.1.2 Remove an Instrument

To remove one of the stations of the current configuration do the following:

• Select the instrument and make a right click

• Click on Remove Station from Configuration

• Press OK

Figure 88: Remove Station from Current Configuration

For more details please see GeoDAS Manual.
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C.2 Configuration of Server Parameters

• Press the button Server. . . , the window below appears:

Figure 89: Station server parameters

Group of Controls Description

Network Settings IP address and port of the server, i.e. computer which Geo-
DAS is running on as well as the network Timeout in seconds.
If server has several network interfaces but connections from in-
struments are expected from only one of them, then its IP ad-
dress must be specified. Otherwise, leave it zero, which means
that GeoDAS accepts incoming connection at any interface. The
timeout is used to decide when to terminate current network con-
nection if the remote party does not respond within the indicated
time interval.

Miscellaneous Options Network error is declared if an instrument did not communicate
with GeoDAS within the indicated period of time. Make sure that
this parameter is higher that the communication interval set in the
instrument as described in chapter 9.8

If State-of-health forwarding interval is set to nonzero value,
then SOH reports are collected within this period of time and
only then are forwarded. You can also choose not to delete
SOH reports after processing. If this option is selected, all
received state of health reports remain in the directory \\Geo-
DAS_DATA\StatusFiles \InfoSOH\

Event Detection GeoDAS can be instructed to analyse event data files received
from configured instruments to see if they belong to the same
earthquake and to declare an event if it is so. You need to enable
the option Declare and process triggers of seismic network
in order to do so.

A network event is declared if at least Minimum number of sta-
tions triggered within the Network time frame. Received event
files can be converted to Seisan format and stored in Seisan
database on the same computer.

Customised Data Processing This is not a standard feature of GeoDAS. Therefore please
check the GeoDAS Manual and contact GeoSIG for further de-
tails if you need to use this functionality.



146 / 150
GMSplus User Manual

2023-10-02 / V25

C.3 Instrument Control in GeoDAS

By making a right click on the station name in the window Stations: General Information, several options
become available to control and check the instrument. See the figure below:

Figure 90: Instrument control of the station in GeoDAS

C.3.1 More Information. . . (State of Health of the Instrument)

The status of the instruments can be easily checked if the instrument is set up to transfer periodically the SOH
file to the server. (See details about SOH configuration in chapter 8.4 and 9.8).

• Make right click on the Station in the GeoDAS main window and select More Information. . . , the
following window will appear:

Figure 91: SOH information in GeoDAS
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Information Area Description

Status date and time Before analysing the SOH data always make sure that the SOH files are
current ones by checking the time and date here.

Firmware Here the firmware versions of all components can be viewed.

File and Memory Information about events and available memory

Configuration and Restarts Date and time of the last restart, the last configuration change and the last
shutdown are shown. Additionally the reason of the last shutdown is indi-
cated.

Miscellaneous Ambient temperature, measured inside the instrument. Other information
may appear here, depending on the firmware version of the instrument.

Errors and Warnings List of all errors and warnings of the instrument

Timing and GPS Status of the RTC and the related GPS information if a GPS receiver is con-
nected and configured

Power Status of the power supply and the battery voltages

C.3.2 Instrument Setup. . .

See chapter 9.2.2 for details.

C.3.3 Cancel Pending Request

The pending requests on the server, as shown in the Figure 80, can be canceled by the user.

C.3.4 Instrument Communication Interface

• Make a right click on the Station in the GeoDAS main window and select Instrument Control. . . ; the
following window will appear:

Figure 92: Instrument Communication Interface
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Action or command Description

Request a File Request a file from the instrument (the full path to the file must be
specified)

Request Configuration Menu
Options

The instrument uploads the structure of the configuration menu and
saves the file in \\GeoDAS_DATA\Config\Stationname.mnu. This file
is needed for offline configuration of the instrument as described in
chapter 9.2.1

Request Network Configuration The instrument uploads the network settings of the instrument and
saves the file in \\GeoDAS_DATA\Config\Stationname.net

Request Recorder Configuration The instrument uploads the configuration of the instrument and
saves the file in \\GeoDAS_DATA\Config\Stationname.xml. This file
is needed for offline configuration of the instrument as described in
chapter 9.2.1

Request Trim Table The instrument will upload a SOH file containing the actual values
from the RTC trim table. The latest SOH file can be found under
\\GeoDAS_DATA\StatusFiles\InfoSOH.xml

Reset Error State The instrument will clear all errors and warnings.

Reset Trim Table The instrument will clear the RTC trim table.

Send a Request Sends a user request to the instrument. For details see chapter
9.12.1

Send a Script The instrument will download and execute the attached script. This
function is for advanced users only, as it can seriously damage the
instrument if the script is not written correctly.

Send an Upgrade The instrument will download the attached file, which can be any
type of the firmware, namely: Bootloader, RTC, DSP, main firmware
and or the entire Linux image. For more details about the upgrade
of the firmware, see chapter 11.

Send Binary Network Configuration The instrument will download binary network configuration file from
the server.

Send Network Configuration The instrument will download the attached manually adjusted net-
work configuration file from the server.

Send Recorder Configuration The instrument will download the attached manually adjusted
recorder configuration from the server.

C.4 Open recorded miniSEED files in GeoDAS

The system is recording miniSEED files (.MSD). For viewing such files, GeoDAS can be used. As the signal
is stored inside the miniSEED file in counts, a scaling factor has to be applied when opening the data. If an
Extended format of MiniSEED files is used (see the chapter 9.9), scaling factors are applied by GeoDAS
automatically, and you may skip the information below.

• Open GeoDAS

• Open recorded mini-seed file from the menu File → Open. . .

Event files are stored under: \\GeoDAS_ DATA\Data\STATION_NAME
Ringbuffer files are stored under: \\GeoDAS_DATA\DataStreams\STATION_NAME
Testpulses are stored under: \\GeoDAS_ DATA \Incoming\NNNNNN
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• When you open a ‘.MSD’ file with GeoDAS, the following dialog box for scaling factor appears:

Figure 93: GeoDAS miniSEED parameters

• The values Physical unit and Counts per physical unit must be set for correct display data in GeoSIG
software GeoDAS. The values can be calculated as described in chapter C.4.2.

The user has the possibility to tick “Always use the current parameters ” because the unit
gets send with the miniseed file

• Press OK

• If instead of the scale prompt you get directly the graph, to get back the prompt each time you open a
miniSEED file, use menu: Analyse → Parameters. . .→ Parameters of miniSEED files and press Edit :

Figure 94: GeoDAS analysis parameters

• Now the dialog box for scaling factor should be seen. Enter the correct values, close and reopen the file
you want to see. You will be prompted again for scale; just press OK as the scale is now correct.

C.4.1 Save predefined Scaling Factors

The scaling factor set under Counts per physical unit is always valid for all channels in the same miniSEED file.
If the channels have different physical units (e.g. if a six-channel instrument with two different types of sensors
is used) a scaling factor for each channel separately can be defined.

To define a scaling factor for a specific channel, enter the full channel name (e.g. LCAX1) in the filed Channel
name and press Add

All channels which are not specifically defined are converted with the scaling factor saved under Default.
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C.4.2 Calculation of the Scaling Factors

The scaling factor is the inverse of the LSB value.

Scalingfactor =
1

LSB

See section 9.3.3 for details about how to calculate the LSB factor.
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